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Chapter 1:

Introduction to NITF
This chapter provides an introduction to the NITF format. (For information on the NITF Module, 
see Chapter 3, “Introduction to the NITF Module”.) The following topics are discussed in this 
chapter:
Introduction to the Manual  . . . . . . . . . . . . . .  8
The Certified NITF/NSIF Module . . . . . . . . .  9
The NITF/NSIF Format . . . . . . . . . . . . . . . .  10

NITF Display Composites  . . . . . . . . . . . . .  16
References  . . . . . . . . . . . . . . . . . . . . . . . . .  20
NITF Guide 1.0 7
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Introduction to the Manual

The Certified NITF/NSIF Module Guide provides general information about the 
NITF and NSIF formats, and it describes how the Certified NITF/NSIF Module 
works with ENVI to provide NITF and NSIF support. The manual includes 
procedures for installing and using the NITF Module, as well as a technical reference 
for programmers. Additional information on the attributes of NITF datasets and 
Tagged Record Extensions (TREs) is also provided.

• If you are not familiar with the NITF/NSIF format, be sure to read Chapter 1, 
“Introduction to NITF” first.

• If you are a first-time ENVI user, be sure to familiarize yourself with ENVI by 
referring to the ENVI documentation first.

• If you are familiar with NITF and ENVI, you may want to start with Chapter 2, 
“Installing the Module” followed by Chapter 3, “Introduction to the NITF 
Module” and Chapter 4, “Using the Certified NITF/NSIF Module”.

• If you plan to program with ENVI and the NITF Module, you will want to 
refer to the routines described in Chapter 5, “Programming Reference”.
Introduction to the Manual NITF Guide 1.0
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The Certified NITF/NSIF Module

The NITF (National Imagery Transmission Format) Standard is a raster format 
defined by the NITF Standard Technical Board (NTB).

Providing support for the NITF format in IDL and ENVI is a joint development 
project between RSI and Eastman-Kodak. Certified NITF support is provided via an 
ENVI module available at additional cost from RSI or your ENVI distributor. 

The NITF format is controlled by the NTB. The Joint Interoperability Test Command 
(JITC) certifies systems implementing the NITF format for compliance with the 
standard. JITC has examined the Certified NITF/NSIF Module (hereafter referred to 
as the NITF Module) for compliance with this standard and has provided certification 
for the product. The NITF Module has been certified to complexity level 7 (the 
highest) for compliance with the NITF Standard. 

For detailed information about the NITF certification program, including functional 
read/write breakdown and testing anomalies, contact JITC (http://jitc.fhu.disa.mil/).

For more information about the NITF Module, see Chapter 3, “Introduction to the 
NITF Module”.
NITF Guide 1.0 The Certified NITF/NSIF Module
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The NITF/NSIF Format

NITF is a complex imagery and image exploitation information format capable of 
containing a wide variety of image and non-image information. An introduction to 
the format is included here along with some terminology that is used throughout this 
document. Currently, there are three different versions of the NITF specification: 
NITF 1.1, NITF 2.0, and NITF 2.1. Each is similar to the others in many ways, but 
each also has its own characteristics. 

NSIF and NITF

NATO Secondary Image Format (NSIF) is a format used by the multinational 
members of the North Atlantic Treaty Organization (NATO). The NSIF 1.0 format is 
identical to the NITF 2.1 format, with the exception of the version name in the file 
header. In NSIF files, the version field contains NSIF01.00 instead of NITF02.10. In 
this document, general information about the NITF format, and specific information 
about the NITF 2.1 format, also applies to the NSIF format.

NITF Datasets

The terms NITF file and NITF dataset both refer to a disk file containing data stored 
according to the NITF standard, and these terms are used interchangeably in this 
document. Any valid NITF dataset provides a main header identifying the file as an 
NITF dataset and describing the contents of the file. The header is usually followed 
by one or more data segments. Each data segment consists of a segment subheader 
identifying the type and properties of the data, followed by the data itself. 

Data segments can be any of the following types: 

• image

• symbol

• label

• graphic

• text

• extension

Image, text, and extension segments are available in every version of NITF, while 
label and symbol segments can occur only in NITF 2.0 datasets, and graphic 
segments occur only in NITF 2.1 datasets, as shown in Figure 1-1. 
The NITF/NSIF Format NITF Guide 1.0



Chapter 1: Introduction to NITF 11
Image segments contain raster data, typically image data, intended for display or 
analysis (see “Image Segments” on page 13). NITF 2.1 files can contain graphic 
segments with Computer Graphics Metafile (CGM) graphic and graphical text 
elements (see “Graphic/Symbol Segments” on page 14), while NITF 2.0 files contain 
two segment types for the same purpose: symbol segments and label segments. 
Symbol segments can contain CGM, bitmap or object elements (see 
“Graphic/Symbol Segments” on page 14), while label segments contain graphical 
text elements (see “Label Segments” on page 14). Text segments contain text that is 
informational, not graphical (see “Text Segments” on page 15). The two types of 
extension segments, data and reserved, provide storage within the file structure for 
additional information that cannot be contained in the file or segment header. Data 
extension segments are used as necessary for storing Tagged Record Extension 
(TRE), or tag, data (see “Tagged Record Extensions” on page 15), and the reserved 
extension segment is reserved for future expansion of the NITF format.

Main Header

An NITF dataset may contain any or all types of segments available for that version, 
but every NITF dataset must contain a main header. The main NITF header describes 
the entire file, including origination information, file version and size, and the 
number and type of all data segments contained in the NITF dataset. 

Figure 1-1: NITF File Structure
NITF Guide 1.0 The NITF/NSIF Format
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Displayable Segments

While NITF datasets without graphical data are supported, most datasets contain one 
or more displayable segments. Displayable segments are image, graphic, symbol, or 
label segments that contain graphical information and text for display. These 
segments contain instructions about how the graphical data they contain should be 
displayed relative to any other displayable segments, resulting in a composite display 
encompassing all graphical information in the dataset (see “NITF Display 
Composites” on page 16.)

Security Segments

The NITF format was designed to contain information deemed sensitive, so it 
includes header data describing the status of any information that is not available to 
the general public. The main file header contains security information describing the 
security level of the entire NITF dataset, and each segment also contains security 
information in its subheader, as the confidentiality of data within an image may vary. 
The security level of the entire file (T = Top Secret, S = Secret, C = Confidential, R = 
Restricted, U = Unclassified) is the same as or higher than that of the most restricted 
segment in the file. NITF 2.0 uses the same fields as NITF 1.1 to contain security 
information, while NITF 2.1 deprecated some security information fields and added 
new fields. These changes are described in Table 1-1. For a detailed description of 
these security fields, see Appendix A, “Security Attributes”.
The NITF/NSIF Format NITF Guide 1.0
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Image Segments

Image segments in an NITF file contain displayable image information. Each image 
segment contains a single image consisting of one or more bands of data (NITF 2.0 
allows one, three, or four bands of data in an image, and NITF 2.1 allows up to 999 
bands). All bands within an image segment must have the same data type, 
dimensions, storage order, and map information, although these characteristics can 
vary across different image segments. Each image segment may contain specific 
display instructions, including color lookup tables for single band images and default 
display bands for multi-band images. Images can be stored in integer data types in 

NITF 1.1/2.0 Security Fields NITF 2.1 Security Fields

Classification Classification

Codewords Codewords

Control and Handling Control and Handling

Releasing Instructions Releasing Instructions

Declassification Type

Declassification Date

Declassification Exemption

Downgrade

Downgrade Date

Classification Text

Classification Authority Type

Classification Authority Classification Authority

Classification Reason

Security Source Date

Security Control Number Security Control Number

Security Downgrading Instructions

Table 1-1:  NITF 2.0 and NITF 2.1 Security Fields
NITF Guide 1.0 The NITF/NSIF Format
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NITF 2.0 and in integer, real, and complex data types in NITF 2.1. Images can also be 
compressed using a variety of algorithms including JPEG DCT, Vector Quantization, 
Bi-level, and JPEG 2000 (NITF 2.1 only). Images can be broken into blocks, 
providing an orderly set of subimages (or subarrays). Additional information 
describing the collection, intended use, wavelengths, and comments can also be 
stored with the image.

Images that are rotated or have gaps can also contain a mask indicating which 
portions of the image should not be used for display or analysis. Two types of image 
masks are used in NITF files: blocked image masks and transparent pixel masks. 
Blocked image masks can used to mask entire blocks of image data, and transparent 
pixel masks can be used for masking individual pixels or groups of pixels within an 
image block.

Graphic/Symbol Segments

Both the NITF 2.0 symbol segment and the NITF 2.1 graphic segment can contain 
Computer Graphics Metafile (CGM) graphics. CGM graphics can contain complex 
lines and polygons, as well as displayable text. The CGM format allows direct 
control of all display elements contained in the graphic including color, size, and 
orientation of objects. Multiple annotations can be combined in a single CGM, so 
symbol segments with CGM graphics may actually contain multiple sets of graphical 
primitives.

The NITF 2.1 graphic segment can only contain CGM graphics, but NITF 2.0 symbol 
segments can contain other graphical display elements as well. Symbol segments can 
contain bitmaps (color-mapped bitmaps to be displayed on the composite) or objects 
(graphics from a limited set of graphical primitives, including lines, arrows, circles, 
and rectangles). 

For NITF 2.1, the bitmap and object symbol types as well as the label segment have 
been deprecated. Bitmaps are stored in image segments instead of symbols, and 
object symbols and labels been removed in favor of the more general and powerful 
CGM. 

Label Segments

Label segments, available only in NITF 2.0, contain displayable text intended to be 
drawn with the NITF display. In addition to the text to be displayed, a label segment 
includes display instructions such as font, color, size, and a background color to be 
displayed behind the text.
The NITF/NSIF Format NITF Guide 1.0
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Text Segments

Text segments contained in an NITF dataset consist of textual information that is not 
intended for graphical display. This information may be textual notes explaining 
target information, or the text segment may be used for passing US Message Text 
Format (USMTF) and text notes on to other users. NITF datasets consisting only of a 
header and text segments can be created to store messages or deliver information to 
users of NITF compliant systems. More often, however, text segments are provided 
to supplement the graphic content in the dataset.

Tagged Record Extensions

Tagged Record Extensions (TREs), or tags, may be present in NITF files to contain 
types of information that cannot be stored in the main NITF file header or segment 
subheaders. Tags can be associated with an entire NITF dataset or any segment type 
within an NITF dataset. Tags can be stored in the main header or a subheader, unless 
they exceed a certain size, in which case they can overflow to a data extension 
segment (DES). Each tag is identified by a unique six-character name. 

Tags come in two forms: Registered Extensions (REs) and Controlled Extensions 
(CEs). The NITF Standard Technical Board (NTB) maintains a registry of known 
CEs and REs: the main difference between them is that both the tag name and tag 
layout of CEs are controlled by the NTB, whereas only the tag names of REs are 
registered with the NTB to prevent different users from using the same tag name. 
Therefore, CEs can be interpreted based on the published information contained in 
the NTB repository, whereas REs require specific knowledge of the tag contents 
available to the creator of the tag that may not be available to the data consumer. 

An example of a tag is the RPC00B (Rapid Positioning Coordinate) tag that can be 
associated with an image segment in an NITF dataset and provides coefficients that 
can be used to orthorectify the associated image segment. Other Controlled tags 
specify processing history, information about specific targets in an image, collection 
information, and other types of meta data.

The JITC repository of Controlled Extension and Registered Extension tags can be 
viewed online at http://jitc.fhu.disa.mil/nitf/tag_reg/tagroup.htm. 
NITF Guide 1.0 The NITF/NSIF Format
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NITF Display Composites

The NITF format supports construction of complex display composites that may 
contain multiple image, graphical, and displayable text elements. These composites 
are built from all displayable segments (image, graphic, symbol, and label) in the 
NITF dataset, making it possible for raw image information and additional 
exploitation material to co-exist nondestructively within the dataset. Each displayable 
segment contained in the NITF dataset contains information controlling the location 
of the display element in the composite. Each segment also contains a display level 
that determines which elements should be displayed on top of others, obscuring the 
lower-level displayable elements from view without corrupting the hidden portion of 
those lower-level displayable elements. 

Figure 1-2 is an example of an NITF 2.1 composite.

Figure 1-2: Sample Composite Image

Main Image

Inset Image CGM Graphics

CGM Graphics
NITF Display Composites NITF Guide 1.0
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In Figure 1-2, a close-up image is positioned on top of the main image, obscuring part 
of the image. However, because the inset image is contained in an image segment 
separate from the main image, it can be moved or deleted without destroying 
information contained in the main image underneath it. Likewise, the CGM graphics 
(text and graphical annotations) can be hidden or displayed without affecting the 
underlying image.

Image Masks

Mask information stored in image segments identifies pixels that are invalid or not 
intended to be displayed, and should therefore not be displayed (see “Image 
Segments” on page 13). When an image segment containing masked blocks or pixels 
is displayed, pixels from images or graphics underneath the image segment show 
through and are displayed even though they would ordinarily be obscured. If a 
transparent pixel occurs with nothing displayed under it, or if for any other reason 
there is no display information for a pixel, the background color specified in the main 
file header is displayed.

Display Levels

Each displayable segment in an NITF dataset is assigned a display level that 
determines the order of display. Segments with higher display levels are displayed 
over those with lower display levels. 

Figure 1-3 shows these levels and their corresponding displayable segments.
NITF Guide 1.0 NITF Display Composites
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Figure 1-3 illustrates the composition of a composite NITF file. In this example, three 
annotation segments are displayed on top of a base image segment, another image 
segment is displayed as an inset, and the composite of these elements is displayed on 
a gray background.

Figure 1-4 shows the composite of the three annotation segments, the two image 
segments, and the gray background. While the annotations obscure portions of the 

Figure 1-3: Layers of an NITF Composite
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underlying image in the composite image, each annotation exists as a separate 
segment that can be displayed or hidden without affecting the underlying image.

Figure 1-4: NITF Composite
NITF Guide 1.0 NITF Display Composites
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References

For more detailed information about the NITF/NSIF format and its components, see 
the appropriate technical specification listed in the following table. These documents 
are available from the NTB Web site http://164.214.2.51/ntb/baseline/docs. Click on 
the document title to open it in your Internet browser:

Other documents, including compression schemes, may be found on the NTB Web 
site: http://164.214.2.51/ntb/baseline/1999.html

For information about... Title

NITF 2.1 MIL-STD-2500B

NITF 2.0 MIL-STD-2500A

NSIF 1.0 STANAG 4545

CGM Graphics MIL-STD-2301A

Controlled Extensions for NITF 2.1 STDI-0002

Test program plan N-0105-98
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Chapter 2:

Installing the Module
This chapter describes how to install the Certified NITF/NSIF Module. It covers the following 
topics:
Before You Begin  . . . . . . . . . . . . . . . . . . . .  22
Windows Installation . . . . . . . . . . . . . . . . . .  24

UNIX Installation . . . . . . . . . . . . . . . . . . . .  26
Licensing the NITF/NSIF Module . . . . . . .  28
NITF Guide 1.0 21
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Before You Begin

Before installing the NITF Module, make sure you have checked the following:

• ENVI 3.6 has been previously installed.

Supported Platforms

Version 1.0 of the NITF Module supports the following platforms and operating 
systems:

† IDL, ENVI, and the NITF Module were either built on the lowest version of UNIX 
listed or tested on that version. It may be possible to install and run IDL, ENVI, and 
the NITF Module on versions other than those listed if your version is binary-
compatible.

For Windows installation instructions, see “Windows Installation” on page 24.

For UNIX installation instructions, see “UNIX Installation” on page 26.

For licensing instructions, see “Licensing the NITF/NSIF Module” on page 28.

About Adobe® Acrobat® Reader

NITF Module online manuals require Adobe Acrobat Reader 3.0 or greater. Acrobat 
Reader has been included on your ENVI 3.6 CD-ROM in the adobe directory. 
Windows users need to run the rp505enu.exe installation application. UNIX users 
need to extract the *.tar file in the Solaris subdirectory, and installation instructions 
are included in the README file included in that *.tar file.

Visit the Adobe Systems Web site at www.adobe.com for the latest Acrobat Reader 
information and downloads.

Platform Vendor Hardware Operating 
System

Supported 
Versions

Windows Microsoft Intel x86 Windows NT 4.0, 2000, XP

UNIX† SUN SPARC Solaris 8, 9

SUN SPARC 
(64-bit Ultra)

Solaris 8, 9

Table 2-1: NITF Module 1.0 Supported Platforms
Before You Begin NITF Guide 1.0
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Contacting RSI

If you have problems with installing or licensing this software product, contact RSI 
technical support for assistance:

• E-mail: support@RSInc.com

• Phone: (303) 413-3920

• Fax: (303) 786-9909

• Web page: http://www.RSInc.com — Visit the Tech Tips section in the 
Support section of our Web page for Frequently Asked Questions.

International customers should contact their local RSI office or distributor for 
technical support.
NITF Guide 1.0 Before You Begin
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Windows Installation

This section describes how to install Version 1.0 of the NITF Module for Windows.

System Requirements

The following are the system requirements for the NITF Module for Windows:

NITF Module Installation Procedure

To install the NITF Module, complete the following steps:

Note
To avoid losing unsaved information, save all open files and close any open 
applications before installing the NITF Module. 

1. Insert the NITF Module CD-ROM in your CD-ROM drive. After a short 
delay, the NITF autorun program starts. If the autorun program does not start 
automatically, select Start → Run. In the Run dialog, type X:\DEMO, where X 
is the name of your CD-ROM drive, and click OK.

2. Start the installation process. Click Install to begin.Then click Next at the 
Introduction and Welcome dialogs to continue.

3. Read the License Agreement. After viewing the license agreement, click Yes 
to continue.

Requirement Description

Disk space 25 MB.

Operating System Windows NT 4.0, Windows 2000, or Windows XP.

ENVI 3.6 ENVI 3.6 must be installed before installing the NITF 
Module. If the installer does not detect ENVI 3.6 
Service Pack 1 in your ENVI 3.6 installation, it will be 
automatically installed for you.

Network Interface Card A network interface card (NIC or Ethernet) is required 
for node-locked and floating licensing.

Table 2-2: NITF Module 1.0 Windows System Requirements
Windows Installation NITF Guide 1.0
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4. View the NITF Module Release Notes. Click Next after viewing the release 
notes.

5. Review the installation settings. At the Start Copying Files dialog, click the 
Next button to begin the installation, or click Back to change any settings.

6. Run the license program. At the License NITF screen, click Yes to run the 
licensing wizard now, or click No to run the licensing wizard at a later time.

7. Click Finish. Your installation is now complete.

Removing Your NITF Module Installation

To remove the NITF Module and restore ENVI with uncertified NITF support:

1. Select Add/Remove Programs from the Control Panel.

2. Select Research Systems Certified NITF/NSIF Module 1.0 from the 
currently installed programs list, click Change/Remove, and follow the 
instructions to remove the installation.
NITF Guide 1.0 Windows Installation
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UNIX Installation

This section describes how to install Version 1.0 of the NITF Module for UNIX.

System Requirements 

The following are the system requirements for installing the NITF Module for UNIX.

Mounting the NITF Module CD-ROM

Some platforms automatically mount the CD-ROM when you insert it into your CD-
ROM drive. On Solaris systems, the CD-ROM will be mounted as:

/cdrom/nitf10

NITF Module Installation Procedure

To install the NITF Module, complete the following steps:

Note
If you are installing the NITF Module to a public directory, make sure you have root 
or similar permissions before running the installation script.

1. Execute the installation script. Enter the following command at your UNIX 
prompt:

/bin/sh /CDROM-PATH/unix/install.sh

where CDROM-PATH is the path to your CD-ROM drive.

The Product Installation dialog appears.

Requirement Description

Disk space 25 MB.

Operating System Solaris SPARC 8 or 9, or SPARC 64-bit Ultra 8 or 9

ENVI 3.6 ENVI 3.6 must be installed before installing the NITF 
Module. If the installer does not detect ENVI 3.6 
Service Pack 1 in your ENVI 3.6 installation, it will be 
automatically installed for you.

Table 2-3: NITF Module 1.0 UNIX System Requirements
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Chapter 2: Installing the Module 27
2. Read and accept the license agreement. To continue the installation, you 
must accept the terms of the Research Systems license agreement. Enter Y to 
accept the license agreement.

3. Enter the installation directory where ENVI 3.6 is installed. The default 
installation directory is /usr/local/rsi. 

4. If ENVI cannot be found in the default /usr/local/rsi directory, you will 
be prompted to enter the path to the RSI folder. 

• To install in the /usr/local/rsi directory, enter Y.

• To change it, enter N, then enter the path to where the RSI directory is 
located.

5. Installation finished. The installation is complete when the phrase “The 
installation has successfully been completed” appears.

Unmounting the CD-ROM

You can now unmount the CD-ROM using one of the following commands:

umount /cdrom/nitf10

or 

eject /cdrom/nitf10

Removing Your NITF Module Installation

To remove the NITF Module and restore ENVI with uncertified support for NITF, 
you must run the installation script for ENVI 3.6 SP1:

1. Mount the NITF/NSIF CD-ROM (see above).

2. Execute the Service Pack 1 installer by entering the following command at the 
UNIX prompt:

/CDROM-PATH/unix/sp1_install.sh

where CDROM-PATH is the path to your CD_ROM drive.

3. Enter the installation directory. The default is /usr/local/rsi.

4. The installation is complete when the phrase “The installation has successfully 
been completed” appears.
NITF Guide 1.0 UNIX Installation
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Licensing the NITF/NSIF Module

The NITF Module requires a new ENVI license. If you have not already obtained a 
new license, contact RSI or your ENVI distributor to purchase a new ENVI license 
key. For information about entering your new ENVI license, refer to your Installing 
& Licensing ENVI 3.6 manual.
Licensing the NITF/NSIF Module NITF Guide 1.0
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This chapter provides an introduction to the Certified NITF/NSIF Module. (For information on the 
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The Certified NITF/NSIF Module

Providing support for the NITF format in IDL and ENVI is a joint development 
project between RSI and Eastman-Kodak. ENVI provides partial support for reading 
and writing some NITF files, but for NITF support that is fully compliant with the 
NITF standard, an ENVI module is required. Certified NITF support is provided via 
the Certified NITF/NSIF Module, available at additional cost from RSI or your ENVI 
distributor. 

The Joint Interoperability Test Command (JITC) certifies systems implementing the 
NITF format for compliance with the NITF standard. JITC has examined the NITF 
Module for compliance with this standard and has provided certification for the 
product. The NITF Module has been certified to complexity level 7 (the highest) for 
compliance with the NITF Standard. 

For detailed information about the NITF certification program, including functional 
read/write breakdown and testing anomalies, contact JITC (http://jitc.fhu.disa.mil/).

The NITF Module provides JITC-certified support for the NITF file format. With the 
NITF Module, ENVI can read and display all compressed or uncompressed NITF 
version 2.0 and 2.1 and NSIF 1.0 files, as well as legacy NITF 1.1 files, and can write 
NITF version 2.0 and 2.1 and NSIF 1.0 files. 

This chapter provides an overview of how the NITF Module enables ENVI to read 
and write NITF files, and it describes some of the important features of the NITF 
Module. For detailed information about the NITF format, see Chapter 1, 
“Introduction to NITF”. 
The Certified NITF/NSIF Module NITF Guide 1.0
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The NITF/NSIF Format

NITF is a complex imagery and image exploitation information format capable of 
containing a wide variety of image and non-image information. For information on 
the NITF format, see Chapter 1, “Introduction to NITF”. The NITF Module enables 
ENVI users to read NITF 2.0, NITF 2.1, NSIF 1.0 and legacy NITF 1.1 files, and to 
write NITF 2.0, NITF 2.1, and NSIF 1.0 datasets.

NSIF and NITF

The NITF format is used extensively in the United States. The multinational 
members of the North Atlantic Treaty Organization (NATO) use the NATO 
Secondary Image Format (NSIF). The NSIF 1.0 format is identical to the NITF 2.1 
format, with the exception of the version name in the file header. In place of 
NITF02.10, this field contains NSIF01.00. 

Note
In this document, general information about NITF files, and any specific 
information about NITF 2.1 files, also applies to NSIF files.
NITF Guide 1.0 The NITF/NSIF Format
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Annotation Segments

In the NITF Module, NITF 2.0 symbol and label segments, as well as NITF 2.1/NSIF 
1.0 graphics segments, are collectively referred to as annotation segments, as 
illustrated in Figure 3-1. 

Because of the similarity between the symbol segments and label segments in NITF 
2.0 files, and the graphic segments in NITF 2.1 files, the NITF Module combines 
these segments into a single conceptual type (annotation segments). Annotation 
segments can contain symbol, label, or graphic segments, and they might include 
text, ellipses, polylines, bitmaps, and other objects. Annotation segments do not exist 
in any NITF file, and they are not mentioned in the NITF specification documents. 
They are a simplification used to reduce the overall number of segment types.

Annotation segments and image segments both carry information intended to be 
displayed graphically, and both are referred to as displayable segments in this 
document.

Figure 3-1: NITF 2.0 /2.1 File Segments and Annotations

Annotation Segments

Annotation Segments
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Annotation Objects

Because CGM graphics are capable of displaying multiple graphical elements, each 
annotation segment must be capable of storing multiple displayable features. In the 
NITF Module, these displayable features are referred to as annotation objects. Each 
annotation segment contains one or more annotation objects. Multiple CGM 
annotation objects can be contained in NITF 2.0 and 2.1 annotation segments; only 
one non-CGM label, bitmap or object symbol annotation object can be contained in 
each NITF 2.0 annotation segment. The type of object determines which fields will 
be filled in the annotation object. See “Annotation Object Attributes” in Appendix A 
for a description of the attributes of annotation objects.
NITF Guide 1.0 The NITF/NSIF Format
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Images and Composites

Each image segment in an NITF file represents a raster dataset that may have its own 
unique value for analysis or visualization. For that reason, the raw data from each 
segment must be accessible. At the same time, the display composite (see “NITF 
Display Composites” on page 16) must also be viewable as intended by the data 
provider. Each of these goals requires distinctly different treatment, but both are 
required.

Most images displayed in ENVI consist of a file containing a single raster dataset 
that, when opened in ENVI, adds one entry to the Available Bands List. NITF files, 
however, can contain multiple images with or without annotations, and these images 
can appear as multiple entries in the Available Bands List. If a raw image contains a 
mask, an additional mask image will be included. On the other hand, an NITF file 
containing only a text segment and no displayable segments will not be added to the 
Available Bands List: the contents of the file will be displayed only in the NITF 
Dataset Attributes viewer.

In ENVI, most images are not automatically displayed when an image is opened. 
Instead, the Available Bands List is displayed, and the user must select the 
appropriate bands and display mode before the image can be displayed. In ENVI with 
the NITF Module, however, many NITF datasets are displayed automatically by 
default. Table 3-1 lists the factors that determine whether images in an NITF dataset 
will be displayed automatically. (For a summary of the factors that determine how 
NITF files are displayed, see “Opening an NITF File” on page 54.)
Images and Composites NITF Guide 1.0
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Factors:

Comments# of Image 
Segments

# of 
Annotation 
Segments

# of Entries in 
the Available 
Bands List

0 0 0 NITF Dataset Attributes 
Viewer is displayed 
automatically.

1 0 1 (image segment) Whether image is 
displayed automatically 
depends on contents of 
IREP and IREPBAND 
(see “Automatic 
Display of Datasets” on 
page 37).

0 1 1 (composite) Annotation is contained 
in the composite and 
displayed over the 
background color.

1 1 1 image segment + 
1 composite

Annotation is contained 
in the composite.

2 or more 0 2 or more image 
segments + 1 

composite

2 or more 1 or more 2 or more image 
segments + 1 

composite 

Annotations are 
contained within the 
composite.

Note - If one or more text segments are present in the dataset, you will be 
prompted to display the NITF Dataset Attributes viewer.

Table 3-1: Factors That Determine Automatic Display of NITF Datasets
NITF Guide 1.0 Images and Composites
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Information Gathered from the Image Subheader

Wavelength information is imported from the BANDSA tag, if present, or from the 
band subcategory settings if the image category is multispectral or hyperspectral and 
the wavelength information is specified. 

For images containing projection information in the image coordinate representation 
and image geolocation header fields, the georeferencing information is imported into 
ENVI automatically. 

Bands Within Each Image Segment

The name of each image band begins with the number of the image segment in the 
file, e.g., Image Segment #1, followed by the band index, e.g., Band 1. If the 
file contains three bands, the band indices are replaced with R, G, and B. If the 
security level of the image segment is anything other than Unclassified, the 
classification level is prepended to each band name. 
Images and Composites NITF Guide 1.0
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Datasets with a Single Image Segment and No 
Annotations

In ENVI with the NITF Module, an NITF dataset with a single image segment and no 
annotation segments is opened as a single entry in the Available Bands List.  Access 
to the data in this image segment is the same as access to other data in ENVI.

Automatic Display of Datasets

In certain cases, when a dataset is opened, it will be displayed automatically. These 
cases are determined by the contents of the image representation (IREP) and band 
representation (IREPBAND) fields in the image subheader. The IREP values that 
occur most frequently are MONO (monochrome), RGB (three-band true color), 
RGB\LUT (single band image with color palette), MULTI (multi-band imagery), and 
NODISPLY (image not intended for display). The IREPBAND values used in this 
process are R (Red), G (Green), B (Blue), M (Mono), and LU (Look-Up Table). The 
image contains one IREP value for the image segment, and one IREPBAND value for 
each band in the dataset. 

Figure 3-2: Simple NITF Dataset Added to the Available Bands List

Single Image Segment
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In addition, the following factors determine how a dataset will be automatically 
displayed:

• Images with the IREP value RGB\LUT will be displayed in true color by 
default, and the image will be decomposed into red, green, and blue bands.  

• Multiple-band images with three bands identified as R, G, and B will be 
displayed as RGB composites, and the three bands will be represented as red, 
green, and blue bands. 

• If no RGB values are found in the image, and there is a band marked LU, this 
band will be displayed with the lookup table applied.  

• If the image contains a band with the value M, it will be displayed as a 
grayscale image.

• If none of these conditions are encountered, the image will not be 
automatically displayed.

For more information, see “Image Segment Attributes” on page 86 and “Band 
Attributes” on page 104.

Datasets with Multiple Image Segments or with 
Annotations

If an NITF dataset contains multiple image segments, or if it contains one or more 
annotations, a display composite will be created (see Table 3-1). 

The NITF Module always adds display composites to the Available Bands List as 
three-band (RGB) composites, and the ENVI Virtual Mosaic™ feature is used to 
create the composite. Any annotations, or images that appear over annotations, are 
displayed using ENVI’s annotation overlay capability. These annotations appear on 
the composite, not on the individual image segments.

When an NITF composite is created, the component image segments in the file are 
added to the Available Bands List (unless the “Show image segments” preference in 
the NITF configuration file is disabled). These component image segments are 
displayed in much the same way as single-image segments (see “Datasets with a 
Single Image Segment and No Annotations” on page 37), with the exception that 
they are not displayed automatically.
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Note
The NITF image segment containing the appropriate data should be used instead of 
the composite image for any processing in ENVI. For example, to run a 
classification on a hyperspectral image in an NITF file, make sure to select the 
image segment containing the hyperspectral image as input. Using the composite 
will produce invalid results.

Figure 3-3: NITF Dataset with Multiple Image Segments Added to the 
Available Bands List

Display Composite

Component Image 
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Segment Bands
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Composite Extents

NITF files can contain multiple displayable segments, and these segments are 
positioned relative to a two-dimensional Cartesian Common Coordinate System 
(CCS). In the NITF Module, the displayable area is limited to the x and y extents of 
the displayable elements within the dataset. These extents are calculated as a 
rectangle extending from the origin of the CCS to the intersection of two lines drawn 
2 pixels from the edge of any displayable segments in the dataset, as illustrated in 
Figure 3-4. The extents are expressed as the number of rows and columns present in 
the RGB composite created in ENVI.

Figure 3-4: Image Extents Rectangle
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NITF Tag support

Tagged Record Extensions (TRE), or tags, can be associated with an NITF dataset or 
any data segment in the file. Tag data can be viewed in ENVI through the NITF 
Dataset Attributes viewer and, in limited cases, tags are applied to the data in a file or 
segment to enhance the utility of the data. One or more tags that apply to the entire 
NITF dataset can be present in the file header, and each segment (image, annotation, 
or text) can also have one or more tags associated with it. Unless there is a large 
amount of data in a tag, the tag data is stored in the main header or segment 
subheader to which the tag applies. For tags too large to fit in the segment TRE area, 
a data extension segment (DES) is created at the end of the file, and a pointer to this 
DES is stored within the header. For more information about tags in NITF datasets, 
see “Tagged Record Extensions” on page 15.

There are two levels of tag support in ENVI:

• Unsupported tags are those for which no tag definition is available, or the tag 
definition does not match the physical layout of the tag. Only the raw data of 
tags of this type can be viewed. In the NITF Dataset Attributes viewer, 
unknown tags are identified by the text “Definition Unknown” beside the 
name of the tag. To view the raw data associated with this type of tag, open the 
tag container and click Raw Tag Data: Click to View. The ASCII data 
contained in the tag appears in a separate window. 

• Supported tags match a valid tag definition, and the data in these tags can be 
viewed with the appropriate header information in the attribute viewer. These 
tags can be parsed into their specific components, and the value associated 
with each field in the tag is displayed in the Dataset Attributes viewer. To view 
the information contained in this type of tag, open the tag container. Each field 
in the tag will be displayed as a single entry. 

Each tag supported by the NITF Module references an XML tag definition file. 
Definition files for a partial list of the NTB-registered CEs are installed with the 
NITF Module. For a list of the tags installed with the NITF Module, see Appendix B, 
“Supported Tags”. 

These files allow ENVI to interpret the raw data contained in the tag and extract 
specific information written into the file. However, none of the NTB-registered REs 
and only some of the NTB-registered CEs are supported by the NITF Module, and 
definition files for these tags are not installed. Support for tags can be added by 
creating tag definitions for the desired tags. For details contact RSI Technical Support 
(see “Contacting RSI” on page 23). 
NITF Guide 1.0 NITF Tag support
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Creating New NITF Files

The NITF Module can create new NITF datasets from existing raster data. New 
datasets can be created in NITF 2.0, NITF 2.1 and NSIF 1.0 format. In Version 1.0 of 
the NITF Module, datasets containing a single image can be created from existing 
data in NITF and other formats. The NITF Module cannot export Annotation 
segments, text segments, or tags to new NITF datasets. 

NITF image segments can be created in ENVI from any supported data type except 
64-bit integer and complex. Supported data types and other criteria for export are 
described in the following table.

These image segments cannot contain masks or lookup tables used to alter image 
values for display. 

All security and origination information contained in the file is editable by the user. 
In addition, some of the image settings controlling how the image is written, 
including image blocking settings, can be edited. Many of these settings have no 
required values, some have only a short list of acceptable values, and others are 
dependent on the values present in other fields. 

Compression Type NITF 2.0 NITF 2.1

None # of Bands: 1, 3, or 4 

Data Types: 8- or 16-bit 
unsigned integers

# of Bands: 1-999

Data Types: 8-, 16-, or 
32-bit unsigned integers; 
16- or 32-bit signed 
integers; floating-point; 
double.

JPEG DCT # of Bands: 1 or 3 

Data Types: Byte

# of Bands: 1 or 3 

Data Types: Byte

JPEG 2000 Not available # of Bands: 1-999

Data Types: 8-, 16-, or 
32-bit unsigned integers; 
16- or 32-bit signed 
integers.

Table 3-2: NITF File Export Criteria
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Validation and Configuration

Before an NITF dataset can be written, the set of parameters to be added to the NITF 
header fields must be checked to ensure internal consistency with the requirements 
set forth in the NITF specification. This validation is performed automatically before 
any new NITF dataset is created. If the validation fails, an error message indicating 
the source of the failure, including the name of the field causing the error and a short 
description of the error, is generated. In most cases, you will have the opportunity to 
correct any errors before continuing.

The NITF Module attempts to determine a reasonable set of default values for all of 
the file parameters before a file is exported. You will, however, always have the 
ability to edit these values before creating an output file. Many of the default values, 
such as the image size and data type, are determined by the data being exported. 
Other values, such as the file and image title, are left blank by default. The 
information that can be edited is displayed in the NITF Dataset Attribute viewer (see 
“Editing Dataset Attribute Values” on page 63).

Some of the information written into the file, such as origination information and 
security settings, will be the same for all files you create. For these settings, you can 
set preferences in the NITF Configuration File to populate these fields by default. It is 
highly recommended that you customize these settings prior to creating any new 
NITF datasets. See “The NITF Configuration File” on page 46. 

Saving an NITF File as NITF

When the source data for a new NITF file is an NITF dataset, the default settings 
from the source dataset will be used for the new file, with the following exceptions: 

• The file date and time will be set to the current date and time.

• The number of file copies will be incremented (unless it is currently set to 0) 
and this copy number will be set to the number of copies. 

• Any annotation segments, tags, or text segments will be removed.

• Any image segment with a compression setting not supported for output will 
default to uncompressed. 

Note
The NITF Configuration file has a setting, overwrite inherited header (see 
“The NITF Configuration File” on page 46), for disabling the automatic use of 
source NITF dataset attributes for output. This causes the new NITF dataset to use 
NITF Guide 1.0 Creating New NITF Files
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the same default settings that would be used by a dataset from a non-NITF format 
being converted into NITF (see “Exporting an ENVI File to NITF” following).

Exporting an ENVI File to NITF

Since default settings must be created for a dataset being exported, ENVI uses all 
available information about the data in ENVI, along with information from the NITF 
Configuration file, to create useful settings. 

Main Header

The version, origination, security information, and background color in the main 
header are set from the NITF Configuration file. The file date and time are set to the 
current time. All other fields in the main header are left blank. 

Image Segments

Image segments are populated in this way:

• Security information for the image segment is read from the NITF 
Configuration file, and the image date and time are set. For NITF 2.1 files, the 
date and time is set to UNKNOWN; for NITF 2.0 files, the date and time is set 
to Jan 1, 1970 (because NITF 2.0 does not recognize UNKNOWN). 

• The number of rows, columns, bands, and the data type of the output dataset 
is determined from the input dataset. If the number of rows and columns is less 
than 4096, the block size is set to the full image size. For larger images, the 
image is set to a block size of 1024x1024. 

• By default, the image will be uncompressed. 

• If the image has map information in UTM, this information will be written to 
the file using the MGRS representation supported in both NITF 2.0 and 2.1. 
Other map information will be converted into geographic coordinates for 
export.

• For single-band images, the image representation field is set to MONO and the 
band representation is set to M, while three-band byte images have RGB as the 
image representation, with the band representations set to R,G, and B (see 
Table 3-3). For any other band count, the image representation will be set to 
MULTI and, if a set of default bands is specified in ENVI for this file, these 
Creating New NITF Files NITF Guide 1.0



Chapter 3: Introduction to the NITF Module 45
bands will have their representations set to R, G, and B to indicate that these 
bands should be displayed by default. 

• If wavelength information is not available for the file, or if only one band is 
being exported, the image category is set to VIS, and the band subcategory is 
left blank. If wavelength information is available, ENVI will attempt to convert 
the wavelength into nanometers, then write that information into the band 
subcategory. In this case, the image category is set based upon the number of 
input bands: HS is used for files with more than 200 bands, and MS is used for 
files with 2-200 bands. All other fields are left blank. 

Type of Image
Image 

Representation
Band 

Representation

Single-band image MONO M

Three-band byte image RGB R, G, B

Other image MULTI R, G, B (if specified)

Table 3-3: Image and Band Representation
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The NITF Configuration File

The NITF configuration file contains configuration information for the NITF Module 
as well as the default origination, security, and compression attributes to be used for 
files saved in NITF format. You can edit the NITF configuration file with any text 
editor to include your own origination information and to change the default security 
attributes of the files you save. 

In Windows, the NITF configuration is located at:

RSI-DIR/IDL56/products/envi36/menu/nitf.cfg

In UNIX, the NITF configuration is located at:

RSI-DIR/IDL_5.6/products/envi_3.6/menu/nitf.cfg

where RSI-DIR is the default installation directory for ENVI.

The following is a sample of the contents of an nitf.cfg file:

NITF Configuration File
show image segments = 1
show tag description = 1
cache size = 128
overwrite inherited header = 0
file write version = NITF02.10
file write ostaid = RSI
file write bgcolor = {0,0,0}
file write oname = Research Systems ENVI
file write ophone = 303-786-9900
security write sclas = U
security write 2.1 sclsy =
security write scode =
security write sctlh =
security write srel =
security write 2.1 sdctp =
security write 2.1 sdcdt =
security write 2.1 sdcxm =
security write 2.1 sdg =
security write 2.1 sdgdt =
security write 2.1 scltx =
security write 2.1 scatp =
security write scaut =
security write 2.1 scrsn =
security write 2.1 ssrdt =
security write sctln =
security write 2.0 sdwng =
security write 2.0 sdevt =
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Attribute Display

To change the way file attributes are displayed in the Available Bands List and the 
NITF Dataset Attributes window, change the following:

Cache Size

To improve performance with large NITF images, change the following:

To determine optimal cache size, display the attributes of a representative image in 
the Dataset Attributes viewer, and locate the following information: 

• Number of blocks per row (NBPR)

• Number of pixels per block (horizontal) (NPPBH)

• Number of pixels per block (vertical) (NPPBV)

Setting Description Values

show image 
segments

If set, adds each image 
segment in the file, in 
addition to the NITF 
composite, to the Available 
Bands List.

1 = Display all image 
segments (default).

0 = Display only the 
composite image.

show tag 
description

If set, displays descriptive 
names of tag fields in the 
NITF Dataset Attributes 
window.

1 = Display descriptive 
names (default).

0 = Display field names.

Table 3-4: Display Settings for NITF File Attributes

Setting Description Values

cache size Size in MB of memory 
allocated for use in reading 
NITF images. If not enough 
physical memory is 
available, virtual memory 
will be used.

Set this value to at least the 
amount of memory required 
to load one row of blocks 
across the entire width of 
the image. 

Default: 128

Table 3-5: Cache Size Setting for Displaying NITF Files
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• Number of bits per pixel (NBPP)

• Number of bands in the image

Then use the following formula to calculate the optimal cache size value: 

value = NBPR*NPPBH*NPPBV*(NBPP/8)*Number of Bands / 1 MB

Overwrite Header

To determine whether to overwrite the file headers of existing NITF files when they 
are saved as new files, change the following:

Note
If the file header is retained, unsupported compression types will be set to 
none. The file date and time will be set to the current time. If FSCPYS is set, 
it will be incremented and this copy will be set to that number. For more 
details on the default settings, see “Creating New NITF Files” on page 42.

Origination

To determine the origination information in the headers of files saved in NITF 
format, change the following:

Setting Description Values

overwrite 
inherited header

If set, uses default 
information for the output 
NITF Dataset Attributes.

1 = Overwrite

0 = Retain values in source 
NITF header (default) 

Table 3-6: Overwrite Setting for NITF File Headers

Setting Description Values

file write version NITF version in which file 
originated 

NITF02.00

NITF02.10 (default)

NSIF01.00

file write ostaid Station ID of organization 
in which file originated

Size: 10 characters
Default: RSI

Table 3-7: Origination Information for NITF File Headers
The NITF Configuration File NITF Guide 1.0



Chapter 3: Introduction to the NITF Module 49
Security

To set the default security information in the main header and each data segment for 
all files you save in NITF format, change the following:

NITF All Versions

file write bgcolor Background color for file (RGB triplet)
Default: {0,0,0}

file write oname Name of file’s originator Size: 24 characters
Default: Research 
Systems ENVI

file write ophone Telephone number of file’s 
originator

Size: 18 characters
Default: 303-786-9900

Setting Description Values

security write 
sclas

Security classification T  = Top Secret

S = Secret

C = Confidential

R = Restricted

U = Unclassified (default)

security write 
scode

Security codewords. See 
“Codewords” on page 78.

Default: blank

security write 
sctlh

Security control/handling. 
See “Control/ Handling” on 
page 78.

Default: blank

security write 
srel

Security release 
instructions. See “Release 
Instructions” on page 78.

Default: blank

Table 3-8: Security Settings for NITF Files, All Types

Setting Description Values

Table 3-7: Origination Information for NITF File Headers (Continued) 
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NITF Version 2.0 Only

NITF Version 2.1 Only

security write 
scaut

Security classification 
authority. See 
“Classification Authority” 
on page 81.

Default: blank

security write 
sctln

Security control number. 
See “Control Number” on 
page 82.

Default: blank

Setting Description Values

security write 2.0 
sdwng

Security downgrade. See 
“(NITF 2.0) Downgrade” 
on page 80.

Default: blank

security write 2.0 
sdevt

Security downgrade event. 
See “(NITF 2.0) 
Downgrade Event” on 
page 80.

Default: blank

Table 3-9: Security Settings for NITF Version 2.0 Files

Setting Description Values

security write 2.1 
sclsy

Security classification 
authority type. See “(NITF 
2.1) Classification 
Authority Type” on 
page 81.

Default: blank

Table 3-10: Security Settings for NITF 2.1 Files

Setting Description Values

Table 3-8: Security Settings for NITF Files, All Types (Continued) 
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security write 2.1 
sdctp

Security declassification 
type. See “(NITF 2.1) 
Declassification Type” on 
page 79.

Default: blank

security write 2.1 
sdcdt

Security declassification 
data and time. See “(NITF 
2.1) Declassification Date” 
on page 79.

Default: blank

security write 2.1 
sdcxm

Security declassification 
exemption. See “(NITF 
2.1) Declassification 
Exemption” on page 79.

Default: blank

security write 2.1 
sdg

Security downgrade level. 
See “(NITF 2.1) 
Downgrade Level” on 
page 80.

Default: blank

security write 2.1 
sdgdt

Security downgrade date. 
See “(NITF 2.1) 
Downgrade Date” on 
page 80.

Default: blank

security write 2.1 
scltx

Security classification text. 
See “(NITF 2.1) 
Classification Text” on 
page 80.

Default: blank

security write 2.1 
scatp

Security classification 
authority type. See “(NITF 
2.1) Classification 
Authority Type” on 
page 81. 

Default: blank

security write 2.1 
scrsn

Security classification 
reason. See “(NITF 2.1) 
Classification Reason” on 
page 82.

Default: blank

Setting Description Values

Table 3-10: Security Settings for NITF 2.1 Files (Continued) 
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security write 2.1 
ssrdt

Security source date. See 
“(NITF 2.1) Security 
Source Date” on page 82.

Default: blank

Setting Description Values

Table 3-10: Security Settings for NITF 2.1 Files (Continued) 
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Chapter 4:

Using the Certified 
NITF/NSIF Module
This chapter describes how to use the Certified NITF/NSIF Module. The following topics are 
covered:
Opening an NITF File . . . . . . . . . . . . . . . . .  54
Viewing NITF Dataset Attributes  . . . . . . . .  55
Viewing NITF Text Segments . . . . . . . . . . .  59

Saving NITF Files  . . . . . . . . . . . . . . . . . . .  61
Personalizing the NITF Configuration File   67
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Opening an NITF File

The following methods can be used to select and open NITF files from the ENVI 
graphical user interface:

• Select File → Open Image File, and select an NITF file to open.

• Select File → Open External File → Military → NITF → NITF, and select 
an NITF file to open.

• If the file you want to open is an IKONOS file in NITF format, select File → 
Open External File → IKONOS → NITF, and select the NITF file to open.

• If the file you want to open is a QuickBird file in NITF format, select File → 
Open External File → QuickBird → NITF, and select the NITF file to open.

• Select File → Open External File → Military → NITF → View NITF 
Dataset Attributes, display attributes for NITF files until you find the one you 
want to open, and click Open. For details on this approach, see “Viewing 
NITF Dataset Attributes” on page 55.

Any of the above methods will open the selected NITF file. The following factors 
determine how the file will be displayed:

• If no displayable segments are present in the file, the NITF Dataset Attributes 
Viewer will display the contents of the file. 

• Files containing displayable segments will have one or more entries added to 
the Available Bands List and may or may not be automatically displayed (see 
“Images and Composites” on page 34). 

• If any images in the file are marked non-displayable (IREP = NODISPLY), you 
will have the option of displaying the file contents in the NITF Dataset 
Attributes Viewer instead of displaying the file in the image viewer. 

• If the file contains any text segments, you will be prompted to display the file 
contents in the NITF Dataset Attributes viewer.

For more information on opening files in ENVI, see “Opening External Files” in the 
ENVI User’s Guide.
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Viewing NITF Dataset Attributes

The NITF Dataset Attribute viewer allows you to view the meta data in the header 
and subheaders of an NITF file. You can also view the contents of tags and text 
segments in the file.

To view the dataset attributes of an NITF file:

1. Select File → Open External File → Military → NITF → View NITF 
Dataset Attributes.

2. Locate the desired NITF file in the Select NITF File dialog, and click Open. 

The attributes of the selected file are displayed in the NITF Dataset Attributes 
window.

Note
The number and type of containers displayed vary according to the dataset 
being displayed, and the attributes displayed in each container vary among 
different versions of NITF.

Figure 4-1: NITF Dataset Attributes Window
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3. Click a + button to expand the File Header, Image Segment, Text Segment, or 
Annotation Segment node in the tree view control. Attributes are grouped in 
the tree view control as follows (click on a container name in the following list 
to view attribute details):

NITF File Header Attributes

• Security Attributes

• Tag Attributes (if present)

Image Segment Attributes (if present)

• Security Attributes

• Band Attributes (one for each band)

• Image Comments (if present)

• Tag Attributes (if present)

Text Segment Attributes (if present)

• Security Attributes

• Tag Attributes (if present)

Annotation Segment Attributes (if present)

• Security Attributes

• Annotation Object Attributes (if present)

• Tag Attributes (if present)

4. From the NITF Dataset Attributes Viewer, you can do any of the following:

• Click Open to open the selected file and add this image to the Available 
Bands List. This button will not be present if the file is already open.

• Click New Dataset to clear the currently selected file and view the 
attributes of another NITF file.

• Click Cancel to dismiss the View NITF Dataset Attributes window.
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NITF Dataset Attribute Icons

The following icons appear in the NITF Dataset Attributes window to identify the 
types of attributes that may appear in a particular container. For more information 
about the attributes in each container, refer to Appendix A, “Dataset Attributes”.

Container Icon Description

File Header
Contains attributes common to the entire NITF file. In 
addition to file attributes, this container can contain tags or 
security attributes pertaining to the entire file.

Security Contains security attributes for the file, image segment, 
annotation segment, or text segment.

Tag Contains attributes for a tag.

Single-band 
Image 
Segment

Contains image attributes for a single-band image 
segment. In addition to information about the image band, 
this container may contain security attributes, image 
comments, and tag attribute containers.

Multi-band 
Image 
Segment

Contains image attributes for a multiple-band image 
segment. In addition to information about the image bands, 
this container may contain security attributes, image 
comments, and tag attribute containers.

Image 
Comments

Contains image comments for an image segment.

Annotation 
Segment

Contains attributes for an annotation segment. In addition 
to one or more annotation object containers, this container 
may contain security and tag attribute containers.

Text 
Annotation 
Object

Contains attributes for a text annotation object.

Ellipse 
Annotation 
Object

Contains attributes for a circular or elliptical annotation 
object.
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Polyline 
Annotation 
Object

Contains attributes for a polyline annotation object.

Polygon 
Object

Contains attributes for a polygon annotation object.

Text 
Segment

Contains attributes for a text segment.

Container Icon Description
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Viewing NITF Text Segments

Text segments in an NITF file must be viewed through the NITF Dataset Attributes 
viewer. To view the text contained in a text segment, first open the NITF file. If the 
file contains only a text segment, opening the file with File → Open Image File will 
automatically open the Dataset Attributes viewer. Alternatively, select File → Open 
External File → Military → NITF → View NITF Dataset Attributes.

To open a file with displayable content and a text segment:

1. Select File → Open Image File. After the file is added to the Available Bands 
List, you will be prompted to open the Dataset Attributes viewer. 

2. Select Yes to open the Dataset Attributes viewer.

3. Select the text segment in the Dataset Attributes viewer to view the data 
contained in that segment. 

4. Click the + button to expand the Text Segment container.

Figure 4-2: Prompt to Open Dataset Attributes Viewer

Figure 4-3: Text Segment Expanded in Dataset Attributes Viewer
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This displays the information in the text segment subheader. 

5. Click <Click to view> to display the text contained within this segment. This 
opens a new ASCII text display window that allows you to view and scroll 
through the text in this text segment. 

6. To save this text to an ASCII file, click File → Save text to ASCII.

Note
To view Unicode (U8S) text, you will need to save the text in the Text 
Segment Window as an HTML file and view it in your Web browser. Use the 
following procedure:

Viewing Unicode Text Segments

1. Follow steps 1-5 above to display the text in the Text Segment Window.

2. Select File → Save Text to ASCII, and specify a filename with a .htm 
extension.

3. Open the .htm file in your Web browser.

4. Set text encoding to Unicode (UTF-8):

• Internet Explorer: Select View → Encoding → Unicode (UTF-8).

• Netscape: Select View → Character Coding → Unicode (UTF-8).

Figure 4-4: Text Segment Text Window
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Saving NITF Files

There are two ways to create new NITF files with the NITF Module:

• Create a dataset that is an exact copy of the data in an existing image. This 
option makes it possible to create datasets of any supported data type, size, or 
number of bands, but it does not allow you to overlay any non-image 
information with this file.  

• Create a dataset with the data that is currently displayed in an ENVI display 
group. This option will create an NITF image of byte type, with one or three 
output bands, and any annotation or vector overlay displayed on the image can 
also be merged into the image data. Any display enhancements applied in the 
display will also be applied to the output data.

Save File As NITF

Use Save File As → NITF to create a dataset that is an exact copy of an existing 
image without any annotation overlays.

To create an NITF file that is an exact copy of a spatial and spectral subset of the data 
in an existing dataset:

1. Select File → Save File As → NITF.
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2. At the NITF Output File dialog, select the output file and perform any 
subsetting.

3. At the NITF Output Parameters dialog, select the desired NITF output version 
from the button menu.

• If the Compression menu is displayed, you may choose a compression 
algorithm to apply to your output image. See “Compression Types” on 
page 63 for details.

Figure 4-5: NITF Output File Dialog

Figure 4-6: NITF Output Parameters Dialog
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• To enter additional parameters such as originator information or header 
details, click the Additional Settings button and make any necessary 
changes to the editable attributes in the NITF Attributes Viewer. See 
“Editing Dataset Attribute Values” on page 63 for details.

4. In the Enter Output Filename field, do either of the following:

• Enter an output filename and click OK. 

• To overwrite an existing NITF file, click Choose, select an existing 
filename, click Open, and click OK.

5. Click OK to export the dataset.

Compression Types

The types of compression available (if any) are determined by the data type 
and the NITF output version selected, as indicated in Table 4-1. Higher 
compression rates result in smaller files with lower quality.

Editing Dataset Attribute Values

Clicking the Additional Settings button in the NITF Output Parameters dialog 
allows you to edit certain file parameters in the NITF Dataset Attributes viewer. 

NITF Output Version Data Type Compression Types

All versions 1- or 3-Band Byte

''

''

JPEG DCT (High) 
(High compression)

JPEG DCT (Medium 
compression) 

JPEG DCT (Low 
compression)

NITF 2.1/NSIF 1.0 only Any Integer data type

''

''

JPEG 2000 (High)
(Lossy)

JPEG 2000 (No Visible 
Loss)

JPEG 2000 (Lossless)

Floating-point, double None

Table 4-1: Compression Types Available
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To edit a file parameter:

1. Click the parameter name in the NITF Dataset Attributes viewer. If the 
parameter is editable, an Edit Value text box is displayed.

2. To edit the displayed value, enter a new value in the Edit Value text box and do 
either of the following:

• Click OK to save your changes and advance to the next editable attribute. 

• Click Cancel to close the text box without saving changes. 

3. When you have finished editing values, do either of the following:

• Click OK to close the NITF Dataset Attributes viewer and save changes.

• Click Cancel to close the viewer and discard changes.

Figure 4-7: Editing Values in the NITF Dataset Attributes Viewer
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For more information about saving files in ENVI, see “Saving Files” in the ENVI 
User’s Guide. 

Save Image As Image File

Use Save Image As → Image File to save the one or three bands currently displayed 
in the ENVI Main Image window with the current stretch applied. Any graphic 
overlays added in the image window, including text, ROIS, annotations and symbols, 
will be merged with the image data when the file is saved.

To create an NITF file from the image displayed in an ENVI display group:

1. Select File → Save Image As → Image File from the Main Image window.

2. At the Output Display to Image File dialog, select NITF from the Output File 
Type drop-down list.

3. Select the NITF output version from the button menu. You will have the 
following options:

Figure 4-8: Output Display to Image File Dialog
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• Choose a compression algorithm to apply to your output image. 
Compression types are determined by the NITF output version selected, as 
indicated in Table 4-1. 

• To enter additional parameters such as originator information or header 
details, click the Additional Settings button and make any necessary 
changes to the editable attributes in the NITF Attributes Viewer (see 
Figure 4-7). 

Note
Regardless of the settings inherited from an NITF source file, the default file 
creation settings (see “Exporting an ENVI File to NITF” on page 44) will be 
used.

4. Enter a filename, or click Choose to overwrite an existing file.

5. Click OK.

Note
Annotations cannot be saved as non-destructive annotation segments in NITF 
files saved with ENVI. The annotations will be saved as part of the image 
and not as an annotation segment separate from the image. This process 
alters the image segment permanently, and the process cannot be reversed.

For more information on saving images, see “Display Output Options” in Chapter 4 
of the ENVI User’s Guide.
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Personalizing the NITF Configuration File

The NITF configuration file (nitf.cfg) contains configuration information for the 
NITF Module as well as the default origination, security, and compression attributes 
to be used for files saved in NITF format. If your ENVI installation is located on your 
own computer or in your home directory, you can simply edit the nitf.cfg file to 
customize the NITF Module for your use. However, if you share your installation of 
ENVI with other users, before you can customize ENVI and the NITF Module for 
your use, you will need to follow these steps:

Note
UNIX users: See Tech Tip #1790 on the RSI Tech Support Web site for complete 
instructions on setting up personal configuration information on a shared ENVI 
installation.

1. Copy the nitf.cfg file to your home directory from the installation directory.

2. Copy the e_locate.pro file, which can be found in the ENVI menu 
directory, into your home directory. The presence of a .pro file in your home 
directory will cause IDL to add your home directory to the search path when it 
starts up, allowing ENVI to find your copy of the nitf.cfg file.

3. Add your home directory to the ENVI search path by doing either of the 
following:

• Windows users: Start ENVI and select Preferences from the IDL File 
menu. Click the Path tab, and add your home directory to the search path.

• UNIX users: Add a line to your .cshrc file that will source the ENVI 
setup file from your home directory when you log into the system. This 
setup will ensure that ENVI will find the files in your home directory 
before it finds the copies of them which are in the default installation 
location, where you don't have write permission. The line in your .cshrc 
file which sources the ENVI setup file should look something like this:

source 
/usr/local/rsi/idl_5.6/products/envi_3.6/bin/envi_setup; 
setenv IDL_PATH '+/home/myusername:'$IDL_PATH 

You will need to change the home directory path, shown here as 
+/home/myusername, to your own home directory path. You may also 
need to change the path to the envi_setup file if your ENVI installation 
is in a location other than /usr/local/rsi.
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See ENVI Online Help or the ENVI User’s Guide for information on 
personalizing your ENVI installation.

4. You may now edit the file.
Personalizing the NITF Configuration File NITF Guide 1.0
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Programming 
Reference
This chapter provides reference information for programming with the Certified NITF/NSIF 
Module. It covers the following topics:

ENVI_OPEN_DATA_FILE . . . . . . . . . . . . .  70
ENVI_OUTPUT_TO_EXTERNAL_FORMAT  71
Example Program  . . . . . . . . . . . . . . . . . . . .  73
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ENVI_OPEN_DATA_FILE

Use this routine to open a data file. For NITF files, use the NITF keyword. For other 
formats, see “ENVI_OPEN_DATA_FILE” in the ENVI Reference Guide.

Syntax

ENVI_OPEN_DATA_FILE, Name

Arguments

NAME

The filename to open. The type of the file is indicated by setting the proper keyword.

Keywords

NITF (optional)

Set this keyword to specify that the file being opened is a NITF file.

R_FID (optional)

Use this keyword to specify a named variable that will contain the file ID for the 
opened data. This file ID can be used to access the processed data.
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ENVI_OUTPUT_TO_EXTERNAL_FORMAT

Use this routine to output image data to external formats. This routine allows output 
of NITF and other formats. For other formats, see 
“ENVI_OUTPUT_TO_EXTERNAL_FORMAT” in the ENVI Reference Guide.

Note
NITF datasets have many properties, all of which are set for you automatically 
when you export an NITF file. See “Creating New NITF Files” on page 42 for a 
description of these default settings.

Syntax

ENVI_OUTPUT_TO_EXTERNAL_FORMAT

Keywords

DIMS

Use this keyword to specify the spatial dimensions on which to perform the 
operation. DIMS is a five-element array of long integers with the following 
definitions:

• DIMS(0): Unused for this function, set to -1.

• DIMS(1): The starting X pixel. (The first pixel is number zero.)

• DIMS(2): The ending X pixel.

• DIMS(3): The starting Y pixel. (The first pixel is number zero.)

• DIMS(4): The ending Y pixel.

FID

Use this keyword to specify the file ID for the open file. This is the value returned 
from the keyword R_FID in the ENVI_OPEN_FILE procedure. FID is a long integer 
with a value greater than zero. An invalid file ID is specified as -1.

OUT_NAME

Use this keyword to specify an output file name for the resulting data. The output file 
will be in the format specified by one of the following keywords, ARCVIEW, ASCII, 
ENVI, ERMAPPER, ERDAS, PCI or TIFF.
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POS

Use this keyword to specify an array of band positions, indicating the band numbers 
on which to perform the operation. POS is an array of long integers, ranging from 
zero to the number of bands-1.

NITF (optional)

Set this keyword to specify output to an NITF formatted file.
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Example Program

This sample code demonstrates the use of the ENVI_OPEN_DATA_FILE and 
ENVI_OUTPUT_TO_EXTERNAL_FORMAT routines. This code requires an NITF 
file that can be written with the ENVI NITF module (see “Creating New NITF Files” 
on page 42 for criteria) as input.

pro envi_copy_file_nitf
compile_opt idl2

  ;Allow the user to select an NITF file to open
  fname=envi_pickfile(filter='*.ntf')

  ; Open the NITF file in ENVI
  envi_open_data_file, fname, /nitf, r_fid=fid

  ; Gracefully exit if the user picked a bogus file
  if (fid eq -1) then return

  ;Query the number of samples, lines, and bands in the file
  envi_file_query, fid, ns=ns, nl=nl, nb=nb

  ; Select all bands in the file for output
  pos = lindgen(nb)

  ; Export the entire spatial extent of the dataset
  dims = [-1,0,ns-1,0,nl-1]

  ; Select the name for the new NITF dataset
  out_name = fname + '_copy.ntf'

  ; Export the NITF file, referenced by file id
  envi_output_to_external_format, /nitf,$
    fid=fid, pos=pos, dims=dims, out_name=out_name
end
NITF Guide 1.0 Example Program
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Dataset Attributes
This appendix describes the following Certified NITF/NSIF Module dataset attributes:
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Annotation Segment Attributes  . . . . . . . .  109
Annotation Object Attributes . . . . . . . . . .  112
Text Segment Attributes . . . . . . . . . . . . . .  116
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Dataset Attribute Tables

This chapter contains descriptions of the attributes of NITF segments derived from 
the NITF 2.0 and NITF 2.1 specification documents (MIL-STD-2500A and MIL-
STD-2500B). Please refer to these documents (and their update NOTICEs) for 
complete information. 

As explained in “The NITF/NSIF Format” on page 10, different versions of NITF 
include different dataset attributes. Where possible, we have identified those 
attributes associated only with a particular version of NITF.

The NITF Module’s NITF Dataset Attributes viewer lists some attributes slightly 
differently from the way they are presented in the specification documents mentioned 
above. The data attribute tables presented in this appendix follow the listing of 
attributes in the NITF Module Dataset Attributes viewer. They differ from the 
specification documents in the following ways:

• NITF 2.0 symbol segments and label segments, as well as NITF 2.1 graphic 
segments, are classified together in the Dataset Attributes viewer as annotation 
segments. 

• Tagged Record Extensions (TREs) are classified in the Data Attribute Viewer 
as Tags.

In the Dataset Attribute Tables, all of the possible attributes in each Dataset 
Attributes viewer container are described. Each attribute is identified by a name that 
appears in the Dataset Attributes viewer. 
Dataset Attribute Tables NITF Guide 1.0
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Security Attributes

Each NITF file segment (header, image segment, text segment, annotation segment) 
contains a security segment. The following attributes can be found in any of the 
Security Segment containers (File Security, Image Security, Text Security, and 
Annotation Security) in the NITF Dataset Attributes viewer (see “Viewing NITF 
Dataset Attributes” on page 55).

Attribute
Field 

ID Description

Classification SCLAS The classification level of the entire file, image, text, o
annotation. Valid values are:

• T = Top Secret

• S = Secret

• C = Confidential

• R = Restricted

• U = Unclassified

(NITF 2.1) 
Classification System

SCLSY The national or multinational security system used to 
classify the file, image, text, or annotation. 

National security systems:

• Country Codes per FIPS 10-4

Multinational security systems:

• Codes per DIAM 65-19

If this field is all spaces, it shall imply that no security
classification system applies to the file, image, text, or
annotation.

Table A-1: Security Attributes
NITF Guide 1.0 Security Attributes
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Codewords SCODE An indicator of the security compartments associated 
with the file, image, text, or annotation. Values include
one or more of the tri/digraphs found in DIAM 65-19 
and/or Table A-9 or Table A-10. Multiple entries shall
be separated by single spaces: The selection of a 
relevant set of codewords is application specific. If this
field is all spaces, it shall imply that no codewords 
apply to the file, image, text, or annotation.

Control/ Handling SCTLH Additional security control and/or handling instruction
(caveats) associated with the file, image, text, or 
annotation. Values include digraphs found in DIAM 
65-19 and/or Table A-9 or Table A-10. The digraph 
may indicate single or multiple caveats. The selection 
of a relevant caveat(s) is application specific. If this 
field is all spaces, it shall imply that no additional 
control and handling instructions apply to the file, 
image, text, or annotation.

Release Instructions SREL A list of country and/or multilateral entity codes that 
indicate to which countries and/or multilateral entities
the file, image, text, or annotation is authorized for 
release. 

Country entity codes:

• One or more country codes as found in FIPS 10-4

Multilateral entity codes:

• Codes identifying multilateral entities as found in 
DIAM 65-19.

If this field is all spaces, it shall imply that no release 
instructions apply.

Attribute Field 
ID Description

Table A-1: Security Attributes (Continued)
Security Attributes NITF Guide 1.0
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(NITF 2.1) 
Declassification Type

SDCTP The type of security declassification or downgrading 
instructions which apply to the file, image, text, or 
annotation. Valid values are:

• DD = declassify on a specific date

• DE = declassify upon occurrence of an event

• GD = downgrade to a specified level on a specific
date

• GE = downgrade to a specified level upon 
occurrence of an event

• O = OADR

• X = exempt from automatic declassification

If this field is all spaces, it shall imply that no security
declassification or downgrading instructions apply.

(NITF 2.1) 
Declassification Date

SDCDT The date on which the file, image, text, or annotation i
to be declassified if the value in the Declassification 
Type attribute is DD. If this field is all spaces, it shall 
imply that no declassification date applies.

(NITF 2.1) 
Declassification 
Exemption

SDCXM The reason the file, image, text, or annotation is exemp
from automatic declassification, if the value in the 
Declassification Type attribute is X. Valid values are 
X1 through X8 and X251 through X259. X1 through 
X8 correspond to the declassification exemptions 
found in DOD 5200.1-R, paragraphs 4-202b(1) through
(8) for material exempt from the 10-year rule. X251 
through X259 correspond to the declassification 
exemptions found in DOD 5200.1-R, paragraphs 4-
301a(1) through (9) for permanently valuable material
exempt from the 25-year declassification system. If thi
field is all spaces, it shall imply that a declassification
exemption does not apply.

Attribute Field 
ID Description

Table A-1: Security Attributes (Continued)
NITF Guide 1.0 Security Attributes
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(NITF 2.1) Downgrade 
Level

SDWNG The classification level to which a file, image, text, or 
annotation is to be downgraded, if the values in the 
Declassification Type attribute are GD or GE. Valid 
values are S (=Secret), C (=Confidential), R (= 
Restricted). If this field is all spaces, it shall imply tha
security downgrading does not apply.

(NITF 2.0) Downgrade SDG An indicator that designates the time at which a 
declassification or downgrading action is to take place
The valid values are (1) the calendar date in the forma
YYMMDD, (2) the code "999999" when the 
originating agency's determination is required 
(OADR), and (3) the code "999998" when a specific 
event determines at what point in time declassification
or downgrading is to take place. If this field is all 
spaces, it shall imply that no image security downgrade
condition applies.

(NITF 2.1) Downgrade 
Date

SDGDT The date on which a file, image, text, or annotation is to
be downgraded, if the value in the Declassification 
Type attribute is GD. If this field is all spaces, it shall 
imply that a security downgrading date does not apply

(NITF 2.0) Downgrade 
Event

SDEVT If the Downgrade attribute equals "999998," this 
attribute contains a valid specification of the 
downgrade event. If this attribute contains all spaces, i
implies that an error exists. Valid values for the event 
specification are determined by the application.

(NITF 2.1) 
Classification Text

SCLTX Additional information about file, image, text, or 
annotation classification to include identification of a 
declassification or downgrading event if the values in 
Declassification Type are DE or GE. This field may 
also be used to identify multiple classification sources
and/or any other special handling rules. Values are 
user-defined free text. If this field is all spaces, it shall
imply that additional information about classification 
does not apply.

Attribute Field 
ID Description

Table A-1: Security Attributes (Continued)
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Appendix A: Dataset Attributes 81

 

 

 
 

 

(NITF 2.1) 
Classification Authority 
Type

SCATP The type of authority used to classify the file, image, 
text, or annotation. Valid values are:

• O = original classification authority

• D = derivative from a single source

• M = derivative from multiple sources

If this field is all spaces, it shall imply that 
classification authority type does not apply.

Classification Authority SCAUT The classification authority for the file, image, text, or
annotation dependent upon the value in Classification 
Authority Type. Values are user-defined free text, and 
should contain the following information: 

• Original classification authority name and position
or personal identifier if the value in the 
Classification Authority Type attribute is O.

• Title of the document or security classification 
guide used to classify the file, image, text, or 
annotation if the value in the Classification 
Authority Type attribute is D.

• Derive-Multiple if the file, image, text, or 
annotation classification was derived from multiple
sources. In this case, the originator will maintain a
record of the sources used in accordance with 
existing security directives. One of the multiple 
sources may also be identified in the Classification
Text attribute, if desired. 

If this field is all spaces, it shall imply that no 
classification authority applies.

Attribute Field 
ID Description

Table A-1: Security Attributes (Continued)
NITF Guide 1.0 Security Attributes
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(NITF 2.1) 
Classification Reason

SCRSN The reason for classifying the file, image, text, or 
annotation. Valid values are A through G. These 
correspond to the reasons for original classification pe
E.O. 12958, Section 1.5.(a) through (g). If this field is
all spaces, it shall imply that no classification reason 
applies.

(NITF 2.1) Security 
Source Date

SSRDT The date of the source used to derive the classification
of the file, image, text, or annotation. In the case of 
multiple sources, the date of the most recent source 
shall be used. If this field is all spaces, it shall imply 
that a security source date does not apply.

Control Number SCTLN The security control number associated with the file, 
image, text, or annotation. The format of the security 
control number shall be in accordance with the 
regulations governing the appropriate security 
channel(s). If this field is all spaces, it shall imply that
no security control number applies.

Attribute Field 
ID Description

Table A-1: Security Attributes (Continued)
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NITF File Header Attributes

Each NITF file begins with a file header, whose fields contain identification and 
origination information, file-level security information, and the number and size of 
segments of each type, such as image segment(s), annotation segments(s), and text 
segment(s), contained in the file. The following attributes can be found in the NITF 
File Header container in the NITF Dataset Attributes viewer (see “Viewing NITF 
Dataset Attributes” on page 55). .

Attribute Field ID Description

File name FILE_NAME The name of the NITF file.

File Type VERSION The NITF version of the file: NITF 1.1, 2.0, or 2.1.

Complexity 
Level

CLEVEL A code used in the file header which indicates the 
degree of complexity an interpret implementation 
needs to support to adequately interpret the files. 
NITF 2.0 values: 01, 02, 03, 04, 05, 06. NITF 2.1 
values: 03, 05, 06, 07. Items that differentiate 
complexity include: number of image segments, 
number of symbol segments, number of text 
segments, size of the common coordinate system, 
and size of image data. See MIL-STD-2500B 
NOTICE 2 and MIL-STD-2500A for value details. 

Standard Type STYPE NITF 2.0: System type or capability. This field is 
reserved for future use and shall be filled

with spaces.

NITF 2.1:Standard type or capability. A character 
string that indicates that this file is formatted using 
ISO/IEC 12087-5.

Originating 
Station ID

OSTAID The identification code or name of the 
organization, system, station, or product that 
originated this file. This field should not be left 
blank.

Table A-2: File Header Attributes
NITF Guide 1.0 NITF File Header Attributes
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File Date and 
Time

FDT The date and time of the file’s origination. UTC 
(Zulu) is assumed to be the time zone designator to 
express the time of day. NITF 2.0: 
DDHHMMSSZMONYY, NITF 2.1: 
CCYYMMDDhhmmss.

File Title FTITLE File Title. This field contains the title of the file or 
is filled with spaces.

File Security FILE_SECURITY See Table A-1.

Encryption ENCRYP The value of this attribute is always zero.

File Copy 
Number

FSCOP The copy number of the file. NITF 2.1: If this field 
is all zeros, it shall imply that there is no tracking 
of number file copies.

Number of 
File Copies

FSCPYS The total number of copies of the file. NITF 2.1: If 
this field is all zeros, it shall imply that there is no 
tracking of numbered file copies.

File 
Background 
Color

FBKGC The three color components of the file background 
in the order Red, Green, Blue, where (0x00, 0x00, 
0x00) is black and (0xFF, 0xFF, 0xFF) is white.

Originator’s 
Name

ONAME The name of the operator who originated the file. If 
the field is all spaces, it indicates that no operator 
is assigned responsibility for origination.

Originator’s 
Phone

OPHONE The phone number for the operator who originated 
the file. If the field is all spaces, it indicates that no 
phone number is available for the operator 
assigned responsibility for origination.

File Length FL The length in bytes of the entire file, including all 
headers, subheaders, and data.

Header 
Length

HL The length in bytes of the NITF file header.

Attribute Field ID Description

Table A-2: File Header Attributes (Continued)
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Number of 
Images

NUMIMG The number of separate image items included in 
the file. This field shall be zeros if and only if no 
images are included in the file.

Number of 
Text 
Segments

NUMTEXT The number of separate text items included in the 
file. This field shall be zeros if and only if no text 
items are included in the file.

Number of 
Annotation 
Segments

NUMANNO The number of label and symbol segments in the 
file.

Number of 
Tags

NUMTAGS The number of tags in the file.

Attribute Field ID Description

Table A-2: File Header Attributes (Continued)
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Image Segment Attributes

Image Segments contain information regarding an image contained within the NITF 
file. An NITF file can contain multiple image segments. The following attributes can 
be found in the Image Segment container in the NITF Dataset Attributes viewer (see 
“Viewing NITF Dataset Attributes” on page 55). 

Attribute Field ID Description

Image ID1 IID1 The alphanumeric identification code associated with 
the image.

Image Date 
and Time

IDATIM The time of the image acquisition. UTC (Zulu) is 
assumed to be the time zone designator to express the 
time of day. NITF 2.0: DDHHMMSSZMONYY, 
NITF 2.1: CCYYMMDDhhmmss

Target ID TGTID The identification of the primary target in the format, 
BBBBBBBBBBFFFFFCC, consisting of ten 
characters of BE (Basic Encyclopedia) identifier, 
followed by five characters of functional category 
code, followed by the two character country code as 
specified in FIPS PUB 10-4.

Image ID2 IID2 The identification of additional information about the 
image.

Image Title ITITLE Image title.

Image Security See Table A-1.

Encryption ENCRYP The value of this attribute is always zero.

Image Source ISORCE A description of the source of the image. If the source 
of the data is classified, then the description shall be 
preceded by the classification, including codeword(s) 
contained in Table A-9 or Table A-10. If this field is 
all spaces, it shall imply that no image source data 
applies.

Table A-3: Image Segment Attributes
Image Segment Attributes NITF Guide 1.0
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Number of 
Rows

NROWS The total number of rows of significant pixels in the 
image. When NPPBV*NBPC > NROWS, the 
remaining last rows (NPPBV*NBPC - NROWS) shall 
contain fill data (that is, only the rows indexed 0 
through NROWS -1 of the image contain “significant” 
data).

Number of 
Columns

NCOLS The total number of columns of significant pixels in 
the image. When NPPBH*NBPR > NCOLS, the 
remaining last pixels of each column (NPPBH*NBPR 
- NCOLS) shall contain fill data (that is, only the 
columns indexed 0 through NCOLS -1 of the image 
contain “significant” data). 

Pixel Value 
Type

PVTYPE The type of computer representation used for the value
for each pixel for each band in the image. Valid entries 
are:

• B = bi-level

• SI = 2’s complement signed integer

• R = real

• C = complex

The data bits of INT and SI values appear in the file in 
order of significance, beginning with the MSB and 
ending with the LSB. INT and SI data types are 
limited to 16 bits. R values are represented as 32-bit 
floating point. C values are represented as Real and 
Imaginary parts, each represented as 32-bit floating 
point and appearing in adjacent four-byte blocks, first 
Real, then Imaginary. B (bi-level) pixel values are 
represented as single bits with value 1 or 0.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Representation

IREP An indicator for the general kind of image represented 
by the data. 

(NITF 2.0) Valid representation indicators are:

• MONO = monochrome

• RGB = red, green, or blue true color

• RGB/LUT = mapped color

• MULTI = multiband imagery

• YCbCr601 = compressed in the CCIR 601 color 
space using JPEG (if IC field = C3)

(NITF 2.1) Valid representation indicators are:

• MONO = monochrome

• RGB = red, green, or blue true color

• RGB/LUT = mapped color

• 1D = monoband data

• 2D = two dimensional data

• ND = multidimensional data

• MULTI = multiband imagery

• NODISPLY = an image not intended for display

• NVECTOR and POLAR = vectors with Cartesian 
and polar coordinates respectively

• VPH = Synthetic Aperture Radar (SAR) Video 
Phase History.

• YCbCr601 = compressed in the ITU-R 
Recommendation BT.601-5 color space using 
JPEG (if IC field = C3, C5, or I1)

This field should be used in conjunction with the 
ICAT, ISUBCATnn, and IREPBANDnn fields to 
interpret the significance of each band in the image.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Category

ICAT  An indicator of the specific category of image, raster 
or grid data. Used in conjunction with the IREP, 
ISUBCATnn, and IREPBANDnn fields to interpret 
the significance of each band in the image.

(NITF 2.0) Valid categories are:

• VIS: visible imagery (default)

• MAP: maps

• SAR: synthetic aperture radar

• IR: infrared

• MS: multispectral

• FP: fingerprints

• MRI: magnetic resonance imagery

• XRAY: x-rays

• CAT: cat scans.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Category 
(cont’d)

ICAT 
(cont’d)

(NITF 2.1) Valid categories include: 

• VIS: visible imagery

• SL: side-looking radar

• TI: thermal infrared

• FL: forward looking infrared

• RD: radar

• EO: electro-optical

• OP: optical

• HR: high resolution radar

• HS: hyperspectral

• CP: color frame photography

• BP: black/white frame photography

• SAR: synthetic aperture radar

• SARIQ: SAR radio hologram

• IR: infrared

• MS: multispectral

• FP: fingerprints

• MRI: magnetic resonance imagery

• XRAY: x-rays

• CAT: CAT scans

• VD: video. 

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Category 
(cont’d)

ICAT 
(cont’d)

Valid categories for geographic products or geo-
reference support data:

• MAP for raster maps

• PAT for color patch

• LEG for legends

• DTEM for elevation models

• MATR for other types of matrix data

• LOCG for location grids. 

This field should be used in conjunction with the 
IREP, ISUBCATnn, and IREPBANDnn fields to 
interpret the significance of each band in the image.

Actual Bits per 
Pixel

ABPP The number of “significant bits” for the value in each 
band of each pixel without compression. Even when 
the image is compressed, ABPP contains the number 
of significant bits per pixel that were present in the 
image before compression. This field is less than or 
equal to Number of Bits Per Pixel (field NBPP). The 
number of adjacent bits within each NBPP is used to 
represent the value. These “representation bits” are 
left justified or right justified within the NBPP field, 
according to the value in the PJUST field. For 
example, if 11-bit pixels are stored in 16 bits, their 
field contains 11 and NBPP contains 16. The default 
number of “significant bits” (if this field is all zeros) is 
the value contained in NBPP.

Pixel 
Justification

PJUST When ABPP is not equal to NBPP, this field indicates 
whether the significant bits are left justified (L) or 
right justified (R). Nonsignificant bits in each pixel 
shall contain the value 0. Right justification is 
recommended.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Coordinate 
System 

ICORDS (NITF 2.0) Code indicating the geo-referenced 
coordinate system for the image. 

The valid values for this field are:

• U = UTM expressed in Military Grid Reference 
System (MGRS) form

• G = Geodetic (Geographic)

• C = Geocentric

• N = None.

(NITF 2.1) Code indicating the type of coordinate 
system used for providing an approximate location of 
the image in the Image Geographic Location field 
(IGEOLO). The valid values for this field are: 

• U = UTM expressed in Military Grid Reference 
System (MGRS) form

• N = UTM (Northern hemisphere)

• S = UTM (Southern hemisphere)

• G = GEOGRAPHIC

• D = Decimal degrees

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Geographic 
Location

IGEOLO (NITF 2.0) If the Image Coordinate System field 
ICORDS value is not N, this field shall contain a valid 
geographic location, in terms of corner locations, of 
the image in the coordinate system specified in the 
ICORDS field. The locations of the four corners of the 
(significant) image data shall be given in image 
coordinate order: (0,0), (0, MaxCol), (MaxRow, 
MaxCol), (MaxRow, 0). MaxCol and MaxRow shall 
be determined from the values contained, respectively, 
in NCOLS and NROWS as MaxCol = NCOLS - 1 and 
MaxRow = NROWS - 1. Valid corner locations in 
geodetic and geocentric coordinates shall be expressed
as latitude and longitude. The format ddmmssX 
represents degrees, minutes, and seconds of latitude 
with X = N or S for north or south, and dddmmssY 
represents degrees, minutes, and seconds of longitude 
with Y = E or W for east or west, respectively. For the 
UTM coordinate system, coordinates shall be 
expressed in UTM grid coordinates (also known as 
Military Grid Reference System (MGRS) coordinates)
to the accuracy indicated by the Value Range 
specification. A description of UTM Grid Coordinates 
can be found in Technical Manual No. 5-241-1 of the 
Department of the Army, GRIDS and GRID 
REFERENCES, 1983.

(NITF 2.1) Approximate geographic location, in terms
of corner locations, of the image in the coordinate 
system specified in the Image Coordinate 
Representation attribute. Coordinates shall be 
populated to the precision of the corner coordinates. 
Non significant digits of the field shall be replaced 
with blanks (for example: “ddmm Xdddmm Yddmm 
Xdddmm Yddmm Xdddmm Yddmm XdddmmY”). 

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Geographic 
Location 
(cont’d)

IGEOLO 
(cont’d)

The locations of the four corners of the (significant) 
image data shall be given in image coordinate order: 
(0,0), (0, MaxCol), (MaxRow, MaxCol), (MaxRow, 
0). 

MaxCol and MaxRow shall be determined from the 
values contained, respectively, in NCOLS and 
NROWS as MaxCol = NCOLS -1 and MaxRow = 
NROWS -1. 

Valid corner locations in geographic coordinates shall 
be expressed as latitude and longitude. The format 
ddmmssX represents degrees, minutes, and seconds of 
latitude with X = N or S for north or south, and 
dddmmssY represents degrees, minutes, and seconds 
of longitude with Y = E or W for east or west, 
respectively. 

For the UTM coordinate system, coordinates shall be 
expressed either in plain UTM coordinates or using 
MGRS. Plain UTM coordinates use the format 
zzeeeeeennnnnnn where “zz” represents the UTM 
zone number, and “eeeeee,” “nnnnnnn” represent 
Easting and Northing. UTM expressed in MGRS use 
format zzBJKeeeeennnnn where “zzBJK” represents 
the zone, band and 100 km x 100 km area within the 
zone and “eeeee,” “nnnnn” represent residuals of 
Easting and Northing. 

Decimal degrees are expressed as ±dd.ddd±ddd.ddd 
(four times) where ±dd.ddd equals latitude 
(“+”=northern hemisphere, “-” = southern 
hemisphere) and ±ddd.ddd = longitude (“+” = eastern 
hemisphere, “-” = western hemisphere). (Null if not 
calculable.) 

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Geographic 
Location 
(cont’d)

IGEOLO 
(cont’d)

Note - Values are provided only to the decimal places 
(precision) warranted by the sources and methods 
used to determine the location. The remaining places 
will be blank. There is no implied accuracy associated 
with the data in this field.

Additional precision for geospatial or geo-referencing 
applications can be found in geospatial related 
extensions if present in the file.

CORNERS The four corners of the image, as determined by the 
Image Geographic Location.

CELLSIZE Pixel size of the image, as determined by the Image 
Geographical Location.

Number of 
Image 
Comments

NICOM The number of 80 character blocks (ICOMn) that 
follow to be used as free text image comments.

Image 
Comments

Image Comment #N: “(Comment)”

Image Comments contain free-form text. They are 
intended for use as a single comment block. If the 
image comment is classified, it is preceded by the 
classification, including codeword(s). This field is 
omitted if the value in the NICOM field is 0.

Attribute Field ID Description
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Image 
Compression

IC Code indicating the form of compression used in 
representing the image data. Values for this field are:

• C1: Bi-level.

• C3: JPEG.

• C4: Vector Quantization.

• C5: Lossless JPEG.

• I1: Down sampled JPEG.

• NC: The image is not compressed. 

• M1, M3, M4, and M5: Compressed images.

• NM: Uncompressed images indicating an image 
that contains a block mask and/or a transparent 
pixel mask. 

The format of a mask image is identical to the format 
of its corresponding non-masked image except for the 
presence of an Image Data Mask at the beginning of 
the image data area. The format and structure of the 
Image Data Mask are shown in MIL-STD-2500B 
NOTICE 2 and MIL-STD-2500A. The definitions of 
the compression schemes associated with codes 
C1/M1, C3/M3, C4/M4, and C5/M5 are given, 
respectively, in ITU-T T-4, AMD2 08/95, MIL-STD-
188-198A, MIL-STD-188-199, and NIMA N0106-97.
C1=ITU-T T-4 AMD2 08/95, C3=MIL-STD-188-
198A, C4= MIL-STD-188-199, and C5= NIMA 
N0106-97.

(NITF 2.1) C6 and M6 are reserved values that will 
represent a future correlated multi-component 
compression algorithm. C7 and M7 are reserved 
values that will represent a future complex SAR 
compression. C8 and M8 are reserved values that will 
represent the future ISO standard compression JPEG 
2000.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Compression 
Rate Code

COMRAT If the Image Compression attribute contains, C1, C4, 
M1, or M4, this field is present and contains a code 
indicating the compression rate for the image. 

If the value in IC is C1 or M1, the valid codes are 1D, 
2DS, and 2DH, where: 

• 1D represents One-dimensional Coding 

• 2DS represents Two-dimensional Coding 
Standard Vertical Resolution (K=2) 

• 2DH represents Two-dimensional Coding High 
Vertical Resolution (K=4) 

(NITF 2.0) Zero is used for the Y value when custom 
Q-Tables are used. Explanation of these codes can be 
found in MIL-STD-188-196. Explanation of the 
compression rate for vector quantization can be found 
in MIL-STD-188-199. Valid codes in this case are 
0.75, 1.40, 2.30, and 4.50. 

If the value in IC is C3 or M3, this field is used to 
identify the default quantization table(s) used by the 
JPEG compression algorithm. In this case, the format 
of this field is XX.Y where XX is the image data type 
(00 = general purpose, 01 through 99 are reserved), 
and Y represents the quality level 1 through 5. 
Explanation of these codes can be found in MIL-STD-
188-198A. 

If the value in IC is C4 or M4, this field shall contain a 
value given in the form n.nn representing the number 
of bits-per-pixel for the compressed image. 
Explanation of the compression rate for vector 
quantization can be found in MIL-STD-188-199. This 
field is omitted if the value in IC is NC or NM. If the 
value in IC is C5, M5, this field is used to identify the 
lossless JPEG algorithm. If the value in IC is I1, this 
field is used to identify the down sampled JPEG 
algorithm. Explanation of the compression rates for 
lossless and down sampled JPEG can be found in 
NIMA N0106-97.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Compression 
Rate Code 
(cont’d)

COMRAT 
(cont’d)

(NITF 2.1) If the Image Compression attribute 
contains, C1, C4, M1, or M4, this field is present and 
contains a code indicating the compression rate for the 
image. 

If the value in IC is C1 or M1, the valid codes are 1D, 
2DS, and 2DH, where: 

• 1D represents One-dimensional Coding 

• 2DS represents Two-dimensional Coding 
Standard Vertical Resolution (K=2) 

• 2DH represents Two-dimensional Coding High 
Vertical Resolution (K=4) 

Explanation of these codes can be found in ITU-T T.4, 
AMD2.

If the value in IC is C3, M3, C5, M5, or I1, the value 
of the field shall identify the embedded quantization 
table(s) used by the JPEG compression algorithm. In 
this case, the format of this field is XX.Y where XX is 
the image data type, and Y represents the quality level 
1 to 5. The image data types are represented by:

• 00 represents General Purpose

• 01 represents VIS

• 02 represents IR

• 03 represents SAR

• 04 represents Downsample (DS) JPEG

Explanation of the optimized tables can be found in 
MIL-STD-188-198A and NIMA N0106-97. The value
of Y shall be 0 if customized tables are used. It is 
optional but highly recommended that the value of XX
still be used for the image type with customized tables.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Compression 
Rate Code 
(cont’d)

COMRAT 
(cont’d)

If the value of IC is C5 or M5, then the value of Y 
shall be 0. It is optional but highly recommended that 
the value of XX still be used for the image type. If the 
value in IC is C4 or M4, this field shall contain a value 
given in the form nn.n representing the number of bits-
per-pixel for the compressed image. Explanation of the
compression rate for vector quantization can be found in 
MIL-STD-188-199.

This field is omitted if the value in IC is NC or NM.

J2K_R_LEVELS Number of JPEG 2000 Reduced Resolution Layers.

Number of 
Bands

NBANDS The number of data bands and multi-spectral bands 
within the specified image. This field and the Image 
Representation attribute are interrelated and 
independent of the Image Mode attribute. The 
corresponding values for (IREP, NBANDS) are 
(MONO, 1); (RGB, 3); (RGB/LUT, 1); (YCbCr601, 
3); (MULTI, 2-9); and 0 for multi-spectral images 
with greater than 9 bands. For 1D, 2D, and ND, 
NBANDS reflects the number of components at each 
data point. When NBANDS contains the value 0, this 
field shall contain the number of bands comprising the 
multi-spectral image.

Band N See Table A-4.

Image Sync 
Code

ISYNC The value of this attribute is always zero.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image Mode IMODE (NITF 2.0) This field shall contain an indicator of 
whether the image bands are stored in the file 
sequentially or interleaved (by block or pixel). Valid 
values are:

B: Band Interleaved by Block

P: Band Interleaved by Pixel

S: Band Sequential

The significance of the IMODE value must be 
interpreted with the knowledge of whether the image 
is JPEG compressed (IC=C3, C5, I1, M3, or M5), 
Vector Quantization (VQ) compressed (IC=C4 or 
M4), or uncompressed (IC=NC or NM). 

When IC=C1 , the use of IMODE is undefined. The 
interpretation of these values of IMODE for this case 
is specified in Paragraph 5.2.3.3 of the NITFS 
document, MIL-STD-188-198A.

For details, see MIL-STD-2500A, Notice 3.

(NITF 2.1) An indicator of whether the image bands 
are stored in the file sequentially, band interleaved by 
block, band interleaved by pixel format, or band 
interleaved by row. Valid values are:

• B: Band Interleaved by Block.

• P: Band Interleaved by Pixel.

• R: Band Interleaved by Row.

• S: Band Sequential.

The significance of the IMODE value must be 
interpreted with the knowledge of whether the image 
is JPEG compressed (IC=C3, C5, M3, or M5), VQ 
compressed (IC=C4 or M4), or uncompressed 
(IC=NC or NM). 

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image Mode 
(cont’d)

IMODE (cont’d) Uncompressed: 

• S indicates band sequential, where all blocks for the 
first band are followed by all blocks for the second 
band, and so on.

• B indicates band interleaved by block. This 
implies that within each block, the bands follow 
one another.

• P indicates band interleaved by pixel within each 
block: such that, for each block, one after the 
other, the full pixel vector (all band values) 
appears for every pixel in the block, one pixel 
after another, the block column index varying 
faster than the block row index.

• R indicates band interleaved by row. The ordering 
mechanism for this case stores the pixel values of each 
band in row sequential order.

JPEG-compressed:

• The presence of B, P, or S implies specific 
ordering of data within the JPEG image data 
representation. For this case the interpretation of 
the various values of the IMODE field is specified 
in MIL-STD-188-198A. When IC contains I1, 
IMODE contains B.

Vector Quantization compressed:

• VQ compressed images are normally either RGB 
with a color look-up table or monochromatic. In 
either case, the image is single band, and the 
IMODE field defaults to B.

Bi-Level Compressed:

• When the value of the IC field is C1 or M1, the 
value of the IMODE field is B.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
NITF Guide 1.0 Image Segment Attributes



102 Appendix A: Dataset Attributes

 

Number of 
Blocks per 
Row

NBPR The number of image blocks in a row of blocks in the 
horizontal direction. If the image consists of only a 
single block, this field shall contain the value one.

Number of 
Blocks per 
Column

NBPC The number of image blocks in a column of blocks in 
the vertical direction. If the image consists of only a 
single block, this field shall contain the value one.

Pixels per 
Block 
Horizontal

NPPBH The number of pixels horizontally in each block of the 
image. 

NBPR*NPPBH ≥ NCOLS.

Pixels per 
Block Vertical

NPPBV The number of pixels vertically in each block of the 
image. 

NBPC*NPPBV ≥ NROWS.

Bits per Pixel NBPP If the Image Compression attribute contains NC, NM, 
C4, or M4, this field shall contain the number of 
storage bits used for the value from each component 
of a pixel vector. The value in this field is always 
greater than or equal to Actual Bits Per Pixel (ABPP). 

Display Level DLVL A value that indicates the graphic display level of the 
image relative to other displayed file components in a 
composite display. The valid values are 001 to 999. 
The display level of each displayable file component 
(image or graphic) within a file shall be unique; that is,
each number from 001 to 999 is the display level of, at 
most, one item. The meaning of display level is 
illustrated in “Display Levels” on page 17. The image 
or graphic component in the file having the minimum 
display level shall have attachment level 0.

Attachment 
Level

ALVL A value that indicates the attachment level of the 
image. Valid values for this field are 0, and the display 
level value of any other image or graphic in the file. 
The image, graphic, or text component in the file 
having the minimum display level shall have 
attachment level 0.

Attribute Field ID Description

Table A-3: Image Segment Attributes (Continued)
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Image 
Location

LOC The location of the first pixel of the first line of the 
image. This field shall contain the image location 
represented as rrrrrccccc, where rrrrr and ccccc are the 
row and column offset from the ILOC or SLOC value 
of the item to which the image is attached. A row or 
column value of 00000 indicates no offset. Positive 
row and column values indicate offsets down and to 
the right and range from 00001 to 99999, while 
negative row and column values indicate offsets up 
and to the left and must be within the range -0001 to -
9999. The location in the common coordinate system 
of all displayable graphic components can be 
computed from the offsets given in the ILOC and 
SLOC fields.

Image 
Magnification

IMAG The magnification (or reduction) factor of the image 
relative to the original source image. Decimal values 
are used to indicate magnification, and decimal 
fraction values indicate reduction. For example, 
“2.30” indicates the original image has been 
magnified by a factor of “2.30,” while “0.5” indicates 
the original image has been reduced by a factor of 2. 
The default value is 1.0, indicating no magnification 
or reduction. 

In addition, the following values shall be used for 
reductions that are reciprocals of nonnegative powers 
of 2: /2 (for 1/2), /4 (for 1/4), /8 (for 1/8), /16 (for 
1/16), /32 (for 1/32), /64 (for 1/64), /128 (for 1/128).

Image Mask 
Present

HAS_MASK If an Image Mask is present, the value of this attribute 
is 1. Otherwise, it is 0.

MASK_VALUE Values of those pixels in the image that contain data 
that is not valid or meaningful and should therefore be 
transparent.

Number of 
Tags

NUMTAGS The number of tags contained in this image segment.

Attribute Field ID Description
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Band Attributes

Each image segment contains a single image of one or more bands of data (NITF 2.0 
allows up to nine bands of data in an image, and NITF 2.1 allows up to 999 bands). 
Band attributes can be found in the Band container in the NITF Dataset Attributes 
viewer (see “Viewing NITF Dataset Attributes” on page 55). .

Attribute Field ID Description

Band 
Representation

IREPBAND When NBANDS contains the value 1, this 
field shall contain all spaces. In all other 
cases, this field shall contain a valid indicator 
of the interpretation of the nnth band. The 
band number is a positive integer when IREP 
contains MULTI. In all other cases, the use of 
this field is user defined. If the IREP field 
contains the value 2D, this field may contain 
LX or LY. However, its purpose is to provide 
the significance of the nnth band of the image 
with regard to the general image type as 
recorded in IREP. The significance of each 
band in the image can be derived from the 
combination of the IREP, IREPBANDnn, 
ICAT, and ISUBCATnn fields. 

(NITF 2.0) 

• If IREP = Mono, IREPBAND1 = 2 spaces 
and NBANDS=1

• If IREP = RGB then IREPBAND1 = R or 
G or B and IREPBANDn = R or G or B 
and NBANDS = 3

• IF IREP = RGB/LUT then IREPBAND1 
= LU and NBANDS = 1

• If IREP = YcbCr then IREPBAND1 = Y 
and IREPBANDn = CB then Cr and 
NBANDS = 3

• If IREP = MULTI the valid values are 
user defined.

Table A-4: Band Attributes
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Band 
Representation 
(cont’d)

IREPBAND 
(cont’d)

(NITF 2.1) The following standard values 
shall apply:

• R, G, B respectively for a Red, Green, 
Blue representation of the band,

• LU for a LUT representation of the band 
(e.g., a three table LUT for RGB and a 
single table LUT for shades of grey),

• M for a monochrome representation of 
the band, spaces for a band not designated 
for display, but may be displayed if 
desired,

• Y, Cb, Cr respectively for the Luminance, 
Chrominance (blue), and Chrominance 
(red) representation of a YCbCr601 
(compressed case only) image, 

The only valid values when IREP contains 
MULTI are M, R, G, B, and LU:

• It is strongly recommended that 3 of the 
multiple bands have the IREPBANDn 
fields populated with R, G, and B.

• When bands marked as LU, R, G, B, and 
M are present, the RGB designated bands 
are the default bands for display. If R, G, 
B are not present, the default displayable 
band is the LU band. If R, G, B, or LU are 
not present, the default displayable band 
is the first M band. When no bands are 
marked with LU, R,G, B, or M the first 
three bands may be displayed as R, G, 
and B respectively. For consistency, 
multispectral images cannot have more 
than one band, each marked as R, G, and 
B.

Attribute Field ID Description

Table A-4: Band Attributes (Continued)
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Band 
Representation 
(cont’d)

IREPBAND 
(cont’d)

• IREPBANDn shall be filled with the M 
value, if the band is to be represented as 
monochrome.

• IREPBANDn shall be filled with the LU 
value, if the band is to be represented 
using a LUT.

• When IREPBANDn is filled with spaces, 
no specific representation is defined for 
the band, but it may be displayed if 
desired. Additional values are reserved 
for specific interpretations and shall be 
coordinated with the Custodian to 
regulate their use.

• The only valid values when IREP 
contains MONO images is M or spaces.

• The only valid values when IREP 
contains RGB images are R, G and B.

• The only valid value when IREP contains 
RGB/LUT images is LU.

• The only valid values when IREP 
contains YCbCr601 images are Y, Cb and 
Cr.

Attribute Field ID Description
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Band 
Subcategory

ISUBCAT This attribute is repeated for each band. The 
use of this attribute is user-defined except for 
the location grids and matrix data. Its purpose 
is to provide the significance of the nnth band 
of the image with regard to the specific 
category (ICAT) of the overall image. An 
example would be the wave length of IR 
imagery. 

For location grids, the number of bands is 
strictly equal to 2; consequently, there are 
only 2 fields ISUBCAT1 and ISUBCAT2. 
Standard values of these fields for the 
Location grids are either ISUBCAT1 = CGX 
and ISUBCAT2 = CGY for the cartographic 
X (Easting) and Y (Northing) bands, or 
ISUBCAT1 = GGX, and ISUBCAT2 = GGY, 
for the geographic X (longitude), and Y 
(latitude) bands. Candidate values for the 
matrix data should be taken from STANAG 
7074 (DIGEST) part 4 annex B.

Attribute Field ID Description

Table A-4: Band Attributes (Continued)
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Image Type ITYPE (NITF 1.1) Type of image:

• BW: Black and white.

• TV

• SAR

• XRAY

• MS: Multispectral. Can include additional 
designators such as TM7 (Themic 
Mapper Band 7).

• FAX: Facsimile

• IR. Can include wavelength, e.g., IR1.06.

• RGB (including Pseudocolor)

• CMY

• YIQ

• A: Alpha channel (transparency)

Image Filter 
Condition

IFC This attribute contains the value N (to 
represent none). Other values are reserved for 
future use.

Image Filter Code IMFLT This attribute is always filled with spaces.

Number of LUTs NLUTS The number of look-up tables associated with 
the nnth band of the image. Use of the look-
up tables is user defined in all cases after the 
first band.

Elements in each 
LUT

NELUT The number of entries in each of the look-up 
tables for the nnth band of data. This field 
shall be omitted if the value in NLUTSnn is 
zero.

Attribute Field ID Description

Table A-4: Band Attributes (Continued)
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Annotation Segment Attributes

Annotation Segment containers in the NITF Dataset Attributes viewer comprise 
NITF 2.0 symbol segment and label segment attributes as well as NITF 2.1 graphic 
segment attributes. The following attributes can be found in the Annotation Segment 
container in the NITF Dataset Attributes viewer (see “Viewing NITF Dataset 
Attributes” on page 55). 

Attribute Field ID Description

File Part Type FILE_PART_TYPE Part type of this annotation:

• SY = Symbol

• LA = Label

Annotation 
ID

ANNO_ID Alphanumeric identification code associated with 
the symbol or label. The valid codes are 
determined by the application.

Annotation 
Name

ANNO_NAME Alphanumeric name for the symbol or label.

Annotation 
Security

P_SEC See Table A-1.

Encryption ENCRYP The value of this attribute is always zero.

Annotation 
Type

ANNO_TYPE Type of this annotation segment:

• B = Bitmap

• C = CGM

• O = Object

• L = Label

Table A-5: Annotation Segment Attributes
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Annotation 
Display Level

DLVL Display level of the symbol or label relative to 
other displayed file components in a composite 
display. The valid values are 001 to 999. The 
display level of each displayable file component 
(image or graphic) within a file is unique; that is, 
each number from 001 to 999 is the display level 
of, at most, one item. The graphic or image 
component in the file having the minimum display 
level has attachment level 0.

Annotation 
Attachment 
Level

ALVL Attachment level of the symbol or label. Valid 
values for this field are 0 and the display level 
value of any other image or graphic in the file. The 
graphic or image component in the file having the 
minimum display level has attachment level 0.

Annotation 
Location

LOC Location specified by providing the location of a 
point bearing a particular relationship to the 
symbol or label. For a CGM graphic, the point is 
the Virtual Device Coordinate (VDC) origin as 
defined in ISO/IEC 8632-1. 

This field contains the graphic location 
represented as rrrrrccccc, where rrrrr and ccccc are 
the row and column offset from the ILOC or 
SLOC value of the item to which the graphic is 
attached. A row and column value of 00000 
indicates no offset. Positive row and column 
values indicate offsets down and to the right and 
range from 00001 to 99999, while negative row 
and column values indicate offsets up and to the 
left and must be within the range -0001 to -9999. 
The location in this common coordinate system of 
all displayable graphic components can be 
computed from the offsets given in the ILOC and 
SLOC fields.

Annotation 
Size

SIZE Dimensions of the annotation. Unique 
measurement used by the NITF/NSIF Module.

Attribute Field ID Description
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Number of 
Annotation 
Objects

NUMOBJECTS Number of annotation objects contained within 
this annotation segment.

Number of 
Tags

NUMTAGS Number of tags contained within this annotation 
segment.

Annotation 
Object

See Table A-6.

Attribute Field ID Description
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Annotation Object Attributes

Each annotation segment contains one or more annotation objects. NITF 2.1 
annotation segments are limited to one CGM annotation object. NITF 2.0 annotation 
objects can be text, line, arrow, polygon, ellipse, or bitmap objects, and the type of 
object determines which fields will be included in the annotation object. The 
following attributes can be found in the annotation object container in the NITF 
Dataset Attributes viewer (see “Viewing NITF Dataset Attributes” on page 55). 

Attribute Field ID Description

Type TYPE Representation type of the symbol or label:

• TEXT

• LINE

• ARROW

• POLYGON

• POLYGON SET

• ELLIPSE

• BITMAP

Text TEXT_STRING For TEXT objects, the text data contained in 
this object.

Text Height TEXT_HEIGHT For TEXT objects, the cell height of this object.

Font TEXT_FONT For TEXT objects, name of the font used for 
this annotation object.

Text Color TEXT_COLOR For TEXT objects, the RGB value of the text 
color of this annotation object.

Text 
Background 
Color

TEXT_BG_COLOR For TEXT objects, the RGB value of the text 
background color of this annotation object.

Line Color LINE_COLOR For LINE or ARROW objects, the RGB value 
of the line color of this annotation object.

Table A-6: Annotation Object Attributes
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Line Style 
(NITF 2.1)

LINE_STYLE For LINE or ARROW objects, the CGM line 
type. The valid values are:

• 1 = solid

• 2 = dashed

• 3 = dotted

• 4 = dash-dot

• 5 = dash-dot-dot

Line Width 
(NITF 2.1)

LINE_WIDTH For LINE or ARROW objects, the CGM line 
width. 

ARROW_HEAD_ANGLE For ARROW objects, the angle of the 
arrowhead.

ARROW_HEAD_LENGTH For ARROW objects, the length of the 
arrowhead.

Fill Color FILL_COLOR For POLYGON, POLYGON SET or ELLIPSE 
objects, the RGB value of the fill color of this 
annotation object.

Fill Style FILL_STYLE For POLYGON, POLYGON SET or ELLIPSE 
objects, the CGM interior fill style for this 
annotation object. The valid values are: 1 
(solid), 2 (hatch), or 3 (empty).

HATCH_INDEX For POLYGON, POLYGON SET or ELLIPSE 
objects, if FILL_STYLE is 2 (hatch), the CGM 
hatch index for this annotation object. The valid 
values are:

• 1 = horizontal

• 2 = vertical

• 3 = positive slope

• 4 = negative slope

• 5 = horizontal/vertical crosshatch

• 6 = positive/negative slope cross

Attribute Field ID Description
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EDGE_VISIBILITY For POLYGON, POLYGON SET or ELLIPSE 
objects, the CGM edge (border) visibility. The 
valid values are:

• 0=off

• 1=on

Center Point ELLIPSE_CENTER For ELLIPSE objects, the Center X and Center 
Y coordinates of a CGM ellipse object, or the 
Circle Ellipse Center coordinates for an NITF 
2.0 symbol object. Valid value is an array of 
two coordinates.

Semi-Major 
Axis

ELLIPSE_RAD1 For ELLIPSE objects, endpoint coordinates of 
Radius 1 of the ellipse. For CGM, this is End1X 
and End1Y. For an NITF 2.0 symbol object, this 
is the semi-major axis. Valid value is an array of 
two coordinates.

Semi-Minor 
Axis

ELLIPSE_RAD2 For ELLIPSE objects, endpoint coordinates of 
Radius 2 of the ellipse. For CGM, this is End2X 
and End2Y. For an NITF 2.0 symbol object, this 
is the semi-minor axis. Valid value is an array 
of two coordinates.

Ellipse Start 
Point

ELLIPSE_START For ELLIPSE objects, coordinates for the 
beginning of the ellipse. 

Ellipse End 
Point

ELLIPSE_END For ELLIPSE objects, coordinates for the end of 
the ellipse.

Type ELLIPSE_CLOSE_TYPE For ELLIPSE objects, the manner in which the 
ellipse is closed. Valid values are:

• -1 = closed by an arc.

• 0 = closed by two radii to form a pie shape.

• 1 = closed by a chord.

• 2 = closed as a complete ellipse.

Orientation ORIEN Orientation of the current annotation.

Attribute Field ID Description

Table A-6: Annotation Object Attributes (Continued)
Annotation Object Attributes NITF Guide 1.0
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Number of 
Points

NPOINTS Number of points in the annotation.

Bits per Pixel 
(NITF 2.0)

BITS_PER_PIXEL The number of bits per pixel in the annotation. 
This number is always greater than the Actual 
Bits Per Pixel (ABPP).

Elements in 
LUT (NITF 
2.0)

NELUT The number of color look-up table (LUT) 
entries in the annotation.

LUT (NITF 
2.0)

LUT Data defining the color look-up table (LUT) 
used for the annotation.

Attribute Field ID Description

Table A-6: Annotation Object Attributes (Continued)
NITF Guide 1.0 Annotation Object Attributes
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Text Segment Attributes

NITF text segments contain non-displayable text. Text segments allow inclusion in 
the NITF file of textual information related to the base image, such as a textual 
description of the activities portrayed in the image. The following attributes can be 
found in the Text Segment container in the NITF Dataset Attributes viewer (see 
“Viewing NITF Dataset Attributes” on page 55). 

Attribute Field ID Description

Text ID TEXTID Alphanumeric identification code associated with the 
text item. The valid codes are determined by the 
application.

Text Date and 
Time

TXTDT The time of origination of the text. UTC (Zulu) is 
assumed to be the time zone designator to express the 
time of day.

Text Title TXTTL Title of the text item.

Text Security P_SEC See Table A-1.

Encryption ENCRYP The value of this attribute is always zero.

Text Format TXTFMT Three-character code indicating the format or type of 
text data. Valid codes are:

• MTF: USMTF (Refer to MIL-STD-6040 for 
examples of the USMTF format)

• STA: BCS-A

• UC2: 2-octet coded characters

• UT1: 1-octet coded characters, Basic Latin and 
Latin Supplement 1. 

Text TEXT Text contained within this text segment.

Number of 
Tags

NUMTAGS Number of tags contained within this text segment.

Table A-7: Text Segment Attributes
Text Segment Attributes NITF Guide 1.0
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Tag Attributes

The Tag attributes can be found in the Tag container in the NITF Dataset Attributes 
viewer (see “Viewing NITF Dataset Attributes” on page 55). 

Note
For more information about tags, refer to the document Controlled Extensions for 
NITF 2.1, STDI-0002 available from the NTB Web site 
(http://164.214.2.51/ntb/baseline/1999.html).

Attribute Field ID Description

Unique Extension 
Identifier

An alphanumeric identifier registered with the 
ISMC.

Length of Entire 
Tagged Record

The length in bytes of the tag data.

Tag Data These attributes contain data of either binary 
or character data types defined by and 
formatted according to user specification. 
Examples of tag data include Cloud Cover, 
Sensor Mode, Source, Project ID Code, etc.

TAG_NAME Name of the current tag.

P_NAME Pointer to an array of strings containing the 
names of each field in the tag.

P_DESC Pointer to an array of strings containing the 
description of each field in the tag.

P_VALUE Pointer to an array of strings containing the 
value of each field in the tag.

Table A-8: Tag Attributes
NITF Guide 1.0 Tag Attributes
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Security Codewords

NITF 2.0 Codewords

Codeword Digraph

NOCONTRACT NC

ORCON OR

PROPIN PI

WNINTEL WI

LIMDIS DS

ATOMAL AL

COSMIC CS

CNWDI CN

CRYPTO CR

FOUO FO

FORM REST DATA RD

SIOP SH

SIOP/ESI SE

COPYRIGHT PX

EFTO TX

LIM OFF USE (UNCLA) LU

NONCOMPARTMENT NT

NOFORN NF

PERSONAL DATA IN

SAO SA

SAO-1 SL

SAO-2 HA

Table A-9: NITF 2.0 Codewords
Tag Attributes NITF Guide 1.0
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SAO-3 HB

SAO-SI-2 SK

SAO-SI-3 HC

SAO-SI-4 HD

SPECIAL CONTROL SC

SPECIAL INTEL SI

SI-1 SN

WARNING NOTICE -

SEC CLAS IS BASED

ON THE FACT OF

EXISTENCE AND AVAIL

OF THIS GRAPHICS

WN

Codeword Digraph

Table A-9: NITF 2.0 Codewords
NITF Guide 1.0 Tag Attributes
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NITF 2.1 Codewords

Codeword Digraph

ATOMAL AT

CNWDI CN

CONFIDENTIAL C

COPYRIGHT PX

COSMIC CS

CRYPTO CR

EFTO TX

FORMREST DATA RF

FOUO FO

GENERAL SERVICE (GENSER) GS

LIM OFF USE (UNCLAS) LU

LIMDIS DS

NATO NS

NO CONTRACT NC

NONCOMPARTMENT NT

ORCON OR

OTHER CODEWORDS USE APPROPRIATE DIGRAPH

PERSONAL DATA IN

PROPIN PI

RESTRICTED DATA RD

SAO SA

SAO-1 SL

SAO-2 HA

Table A-10: NITF 2.1 Codewords
Tag Attributes NITF Guide 1.0
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SAO-3 HB

SAO-SI-2 SK

SAO-SI-3 HC

SAO-SI-4 HD

SECRET S

SIOP SH

SIOP/ESI SE

SPECIAL CONTROL SC

SPECIAL INTEL SI

TOP SECRET TS

UNCLASSIFIED U

US ONLY UO

WARNING NOTICE - SEC CLAS IS 
BASED ON THE FACT OF

EXISTENCE AND AVAIL OF THIS 
GRAPHIC

WN

WNINTEL WI

Codeword Digraph

Table A-10: NITF 2.1 Codewords
NITF Guide 1.0 Tag Attributes
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Appendix B:

Supported Tags
This appendix contains information about the tags supported in the Certified 
NITF/NSIF Module. The following table lists the currently supported tags that ship 
with the NITF Module.

References are provided to the following NITF specification documents:

• STDI0002 = The Compendium of Controlled Extensions for NITF version 2.1

http://164.214.2.51/ntb/baseline/stdi0002/final.pdf

• DIGEST = The Digital Geographic Information Exchange Standard (DIGEST) 
Part 2, Annex D: Image Interchange Format (IIF) Encapsulation Specification

http://www.digest.org/html/gp2d1.htm#A1
NITF Guide 1.0 123
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Tag Name Filename Descriptive 
Name Reference

AIMIDA AIMIDA.xml Additional Image 
Identification

STDI0002

AIMIDB AIMIDB.xml Additional Image 
Identification 
Version B

STDI0002

BANDSA BANDSA.xml Multispectral/ 
Hyperspectral 
Band Parameters

STDI0002

BCKGDA BCKGDA.xml Background Data STDI0002

BLOCKA BLOCKA.xml Image Block 
Information

STDI0002

CMETAA CMETAA.xml Complex 
Metadata Tagged 
Record Extension 
Version A

STDI0002

EXOPTA EXOPTA.xml Exploitation 
Usability Optical 
Information

STDI0002

EXPLTA EXPLTA.xml Exploitation 
Related 
Information 
Version A

STDI0002

EXPLTB EXPLTB.xml Exploitation 
Related 
Information 
Version B

STDI0002

Table B-1: Supported Tags
NITF Guide 1.0
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GEOLOB GEOLOB.xml Local Geographic 
(lat/long) 
Coordinate 
System Extension 

DIGEST

GEOPSB GEOPSB.xml Geographical 
Positioning for 
geo-referencing 
parameters 
including 
datums, 
ellipsoids

DIGEST

GRDPSB GRDPSB.xml Grid Positioning, 
Version B

DIGEST

HISTOA HISTOA.xml Softcopy History 
Tagged Record 
Extension

STDI0002

ICHIPA ICHIPA.xml Image Chip 
Support Data 
Extension Version 
A

DIGEST

ICHIPB ICHIPB.xml Image Chip 
Support Data 
Extension Version 
B

STDI0002

IOMAPA IOMAPA.xml Input/Output 
Mapping Tagged 
Record Extension

STDI0002

MAPLOB MAPLOB.xml Local 
Cartographic 
(x/y) Coordinate 
System Extension

STDI0002

Tag Name Filename Descriptive 
Name Reference

Table B-1: Supported Tags
NITF Guide 1.0
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MENSRA MENSRA.xml Airborne SAR 
Mensuration Data

STDI0002

MENSRB MENSRB.xml Airborne SAR 
Mensuration Data 
Version B

STDI0002

MPDSRA MPDSRA.xml Mensuration Data STDI0002

MSTGTA MSTGTA.xml Mission Target STDI0002

MTIRPA MTIRPA.xml Moving Target 
Information 
Report

STDI0002

MTIRPB MTIRPB.xml Moving Target 
Information 
Report

STDI0002

NBLOCA NBLOCA.xml (Number of 
bytes) image 
Block or frame is 
offset.

STDI0002

OFFSET OFFSET.xml (NITF 2.1) Offset 
of the first pixel 
of an image from 
the first pixel of 
the full image.

STDI0002

PATCHA PATCHA.xml Patch information STDI0002

PATCHB PATCHB.xml Patch information 
Version B

STDI0002

PIAEQA PIAEQA.xml Profile for 
Imagery Archives 
Equipment

STDI0002

Tag Name Filename Descriptive 
Name Reference

Table B-1: Supported Tags
NITF Guide 1.0
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PIAEVA PIAEVA.xml Profile for 
Imagery Access 
Event

STDI0002

PIAIMB PIAIMB.xml Profile for 
Imagery Archives 
Image

STDI0002

PIAIMC PIAIMC.xml Profile for 
Imagery Access 
Image

STDI0002

PIAPEA PIAPEA.xml Profile for 
Imagery Archives 
Person

STDI0002

PIAPEB PIAPEB.xml Profile for 
Imagery Access 
Person

STDI0002

PIAPRC PIAPRC.xml Profile for 
Imagery Archives 
Product

STDI0002

PIAPRD PIAPRD.xml Profile for 
Imagery Access 
Product

STDI0002

PIATGA PIATGA.xml Profile for 
Imagery Archives 
Target

STDI0002

PIATGB PIATGB.xml Profile for 
Imagery Archives 
Target Version B

STDI0002

PRJPSB PRJPSB.xml Projection 
Parameters 
extension

DIGEST

Tag Name Filename Descriptive 
Name Reference

Table B-1: Supported Tags
NITF Guide 1.0
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REGPTB REGPTB.xml Registration 
Points extension

DIGEST

RPCOOB RPC00B.xml Rapid Positioning 
Capability 
Support Data 
Extension

STDI0002

SECTGA SECTGA.xml Secondary Target 
Information

STDI0002

SENSRA SENSRA.xml EO-IR Sensor 
Parameters

STDI0002

STDIDC STDIDC.xml Standard ID 
extension

STDI0002

STREOB STREOB.xml Stereo 
Information

STDI0002

USE00A USE00A.xml Exploitation 
Usability 
extension

STDI0002

Tag Name Filename Descriptive 
Name Reference

Table B-1: Supported Tags
NITF Guide 1.0
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NSDE Tags

For information on obtaining additional tag definition files for NSDE tags, contact 
RSI Technical Support:

• E-mail: support@RSInc.com

• Phone: (303) 413-3920

• Fax: (303) 786-9909
NITF Guide 1.0 NSDE Tags
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annotation objects

attributes, 112
description, 33

annotation segments
attributes, 109
description, 32

automatic display, 37

B
band attributes, 104

C
CD-ROM

mounting, 26
unmounting, 27

Certified NITF/NSIF Module, 9, 30
codewords, 118
composites, 16, 34

extents, 40
configuration file. See NTIF configuration
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dataset attributes

tables, 76
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viewer icons, 57
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datasets
automatic display, 37
definition, 10
validation, 43

display composites, 16, 34
display levels, 17
displaying

multiple image segments, 38
single image segments, 37

E
ENVI_OPEN_DATA_FILE, 70
ENVI_OUTPUT_TO_EXTERNAL_

FORMAT, 71
extents

composite, 40

F
file headers

attributes, 83
description, 11

format
NITF, 10, 31
NSIF, 10, 31

I
icons, 57
image masks, 14, 17
image segments

attributes, 86
bands, 36
description, 13
multiple, 38
saving, 44
single, 37
subheader, 36

installing
licensing, 28
UNIX, 26
UNIX system requirements, 26
Windows, 24
Windows system requirements, 24

L
label segments, 14
licensing, 28

M
main headers

attributes, 83
description, 11

masks, 14, 17
multiple image segments, 38

N
NITF composites, 16, 34
NITF configuration file

attribute display, 47
cache size, 47
description, 46
origination, 48
overwrite header, 48
personalize, 67
saving files, 43
security, 49

NITF Dataset Attributes viewer, 55
icons, 57

NITF datasets, 10
NITF format, 10, 31
NITF security, 12
NSIF format, 10, 31
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opening files, 54

P
personalizing, 67
platforms supported, 22

R
references, 16
RSI contact information, 23

S
saving

annotations, 66
configuration, 43
ENVI file as NITF, 44
files as NITF, 61
image segments, 44
images as image files, 65
NITF file as NITF, 43
validation, 43

security
codewords, 118
NITF, 12
NITF configuration file, 49

security segments
attributes, 77
description, 12

single image segments, 37
supported platforms, 22

UNIX, 22
Windows, 22

symbol segments, 14

T
tags

attributes, 117
description, 15
support, 41

text segments
attributes, 116
description, 15

TREs, 15

U
uninstall

UNIX, 27
Windows, 25

UNIX
installing, 26
removing, 27
supported platforms, 22
system requirements, 26

V
viewing dataset attributes, 55

W
Windows

installing, 24
removing, 25
supported platforms, 22
system requirements, 24
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